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Notice
While reasonable efforts have been made to ensure that the 
information in this document is complete and accurate at the time 
of printing, Avaya assumes no liability for any errors. Avaya reserves 
the right to make changes and corrections to the information in this 
document without the obligation to notify any person or organization 
of such changes.
Documentation disclaimer
“Documentation” means information published in varying media 
which may include product information, subscription or service 
descriptions, operating instructions and performance specifications 
that are generally made available to users of products. 
Documentation does not include marketing materials. Avaya shall 
not be responsible for any modifications, additions, or deletions 
to the original published version of Documentation unless such 
modifications, additions, or deletions were performed by or on the 
express behalf of Avaya. End user agrees to indemnify and hold 
harmless Avaya, Avaya's agents, servants and employees against 
all claims, lawsuits, demands and judgments arising out of, or in 
connection with, subsequent modifications, additions or deletions to 
this documentation, to the extent made by End user.
Link disclaimer
Avaya is not responsible for the contents or reliability of any linked 
websites referenced within this site or Documentation provided by 
Avaya. Avaya is not responsible for the accuracy of any information, 
statement or content provided on these sites and does not 
necessarily endorse the products, services, or information described 
or offered within them. Avaya does not guarantee that these links will 
work all the time and has no control over the availability of the linked 
pages.
Warranty
Avaya provides a limited warranty on Avaya hardware and software. 
Please refer to your agreement with Avaya to establish the terms of 
the limited warranty. In addition, Avaya’s standard warranty language 
as well as information regarding support for this product while under 
warranty is available to Avaya customers and other parties through 
the Avaya Support website: https://support.avaya.com/helpcenter/
getGenericDetails?detailId=C20091120112456651010 under the link 
“Warranty & Product Lifecycle” or such successor site as designated 
by Avaya. Please note that if the product(s) was purchased from an 
authorized Avaya channel partner outside of the United States and 
Canada, the warranty is provided by said Avaya Channel Partner and 
not by Avaya.
“Hosted Service” means an Avaya hosted service subscription that 
You acquire from either Avaya or an authorized Avaya Channel 
Partner (as applicable) and which is described further in Hosted SAS 
or other service description documentation regarding the applicable 
hosted service. If You purchase a Hosted Service subscription, 
the foregoing limited warranty may not apply but You may be 
entitled to support services in connection with the Hosted Service 
as described further in your service description documents for the 
applicable Hosted Service. Contact Avaya or Avaya Channel Partner 
(as applicable) for more information.
Hosted Service
THE FOLLOWING APPLIES ONLY IF YOU PURCHASE AN 
AVAYA HOSTED SERVICE SUBSCRIPTION FROM AVAYA OR 
AN AVAYA CHANNEL PARTNER (AS APPLICABLE), THE TERMS 
OF USE FOR HOSTED SERVICES ARE AVAILABLE ON THE 
AVAYA WEBSITE, HTTPS://SUPPORT.AVAYA.COM/LICENSEINFO 
UNDER THE LINK “Avaya Terms of Use for Hosted Services” 
OR SUCH SUCCESSOR SITE AS DESIGNATED BY AVAYA, AND 
ARE APPLICABLE TO ANYONE WHO ACCESSES OR USES THE 
HOSTED SERVICE. BY ACCESSING OR USING THE HOSTED 
SERVICE, OR AUTHORIZING OTHERS TO DO SO, YOU, ON 
BEHALF OF YOURSELF AND THE ENTITY FOR WHOM YOU ARE 
DOING SO (HEREINAFTER REFERRED TO INTERCHANGEABLY 
AS “YOU” AND “END USER”), AGREE TO THE TERMS OF USE. 
IF YOU ARE ACCEPTING THE TERMS OF USE ON BEHALF A 
COMPANY OR OTHER LEGAL ENTITY, YOU REPRESENT THAT 
YOU HAVE THE AUTHORITY TO BIND SUCH ENTITY TO THESE 

TERMS OF USE. IF YOU DO NOT HAVE SUCH AUTHORITY, 
OR IF YOU DO NOT WISH TO ACCEPT THESE TERMS OF 
USE, YOU MUST NOT ACCESS OR USE THE HOSTED SERVICE 
OR AUTHORIZE ANYONE TO ACCESS OR USE THE HOSTED 
SERVICE.
Licenses
The Global Software License Terms (“Software License Terms”) 
are available on the following website https://www.avaya.com/en/
legal-license-terms/ or any successor site as designated by Avaya. 
These Software License Terms are applicable to anyone who 
installs, downloads, and/or uses Software and/or Documentation. By 
installing, downloading or using the Software, or authorizing others to 
do so, the end user agrees that the Software License Terms create 
a binding contract between them and Avaya. In case the end user is 
accepting these Software License Terms on behalf of a company or 
other legal entity, the end user represents that it has the authority to 
bind such entity to these Software License Terms.
Copyright
Except where expressly stated otherwise, no use should be made 
of materials on this site, the Documentation, Software, Hosted 
Service, or hardware provided by Avaya. All content on this site, the 
documentation, Hosted Service, and the product provided by Avaya 
including the selection, arrangement and design of the content is 
owned either by Avaya or its licensors and is protected by copyright 
and other intellectual property laws including the sui generis rights 
relating to the protection of databases. You may not modify, copy, 
reproduce, republish, upload, post, transmit or distribute in any way 
any content, in whole or in part, including any code and software 
unless expressly authorized by Avaya. Unauthorized reproduction, 
transmission, dissemination, storage, or use without the express 
written consent of Avaya can be a criminal, as well as a civil offense 
under the applicable law.
Virtualization
The following applies if the product is deployed on a virtual machine. 
Each product has its own ordering code and license types. Unless 
otherwise stated, each Instance of a product must be separately 
licensed and ordered. For example, if the end user customer or 
Avaya Channel Partner would like to install two Instances of the 
same type of products, then two products of that type must be 
ordered.
Third Party Components
The following applies only if the H.264 (AVC) codec is distributed 
with the product. THIS PRODUCT IS LICENSED UNDER THE AVC 
PATENT PORTFOLIO LICENSE FOR THE PERSONAL USE OF A 
CONSUMER OR OTHER USES IN WHICH IT DOES NOT RECEIVE 
REMUNERATION TO (i) ENCODE VIDEO IN COMPLIANCE WITH 
THE AVC STANDARD (“AVC VIDEO”) AND/OR (ii) DECODE AVC 
VIDEO THAT WAS ENCODED BY A CONSUMER ENGAGED IN A 
PERSONAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO 
PROVIDER LICENSED TO PROVIDE AVC VIDEO. NO LICENSE 
IS GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE. 
ADDITIONAL INFORMATION MAY BE OBTAINED FROM MPEG LA, 
L.L.C. SEE HTTP://WWW.MPEGLA.COM.
Service Provider
WITH RESPECT TO CODECS, IF THE AVAYA CHANNEL 
PARTNER IS HOSTING ANY PRODUCTS THAT USE OR 
EMBED THE H.264 CODEC OR H.265 CODEC, THE AVAYA 
CHANNEL PARTNER ACKNOWLEDGES AND AGREES THE 
AVAYA CHANNEL PARTNER IS RESPONSIBLE FOR ANY AND 
ALL RELATED FEES AND/OR ROYALTIES. THE H.264 (AVC) 
CODEC IS LICENSED UNDER THE AVC PATENT PORTFOLIO 
LICENSE FOR THE PERSONAL USE OF A CONSUMER 
OR OTHER USES IN WHICH IT DOES NOT RECEIVE 
REMUNERATION TO: (i) ENCODE VIDEO IN COMPLIANCE WITH 
THE AVC STANDARD (“AVC VIDEO”) AND/OR (ii) DECODE AVC 
VIDEO THAT WAS ENCODED BY A CONSUMER ENGAGED IN A 
PERSONAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO 
PROVIDER LICENSED TO PROVIDE AVC VIDEO. NO LICENSE 
IS GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE. 
ADDITIONAL INFORMATION FOR H.264 (AVC) AND H.265 (HEVC) 
CODECS MAY BE OBTAINED FROM MPEG LA, L.L.C. SEE HTTP://
WWW.MPEGLA.COM.
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Compliance with Laws
You acknowledge and agree that it is Your responsibility to comply 
with any applicable laws and regulations, including, but not limited 
to laws and regulations related to call recording, data privacy, 
intellectual property, trade secret, fraud, and music performance 
rights, in the country or territory where the Avaya product is used.
Preventing Toll Fraud
“Toll Fraud” is the unauthorized use of your telecommunications 
system by an unauthorized party (for example, a person who is not a 
corporate employee, agent, subcontractor, or is not working on your 
company's behalf). Be aware that there can be a risk of Toll Fraud 
associated with your system and that, if Toll Fraud occurs, it can 
result in substantial additional charges for your telecommunications 
services.
Avaya Toll Fraud intervention
If You suspect that You are being victimized by Toll Fraud and You 
need technical assistance or support, please contact your Avaya 
Sales Representative.
Security Vulnerabilities
Information about Avaya’s security support policies can be 
found in the Security Policies and Support section of https://
support.avaya.com/security.
Suspected Avaya product security vulnerabilities are handled 
per the Avaya Product Security Support Flow (https://
support.avaya.com/css/P8/documents/100161515).
Trademarks
The trademarks, logos and service marks (“Marks”) displayed in this 
site, the Documentation, Hosted Service(s), and product(s) provided 
by Avaya are the registered or unregistered Marks of Avaya, its 
affiliates, its licensors, its suppliers, or other third parties. Users 
are not permitted to use such Marks without prior written consent 
from Avaya or such third party which may own the Mark. Nothing 
contained in this site, the Documentation, Hosted Service(s) and 
product(s) should be construed as granting, by implication, estoppel, 
or otherwise, any license or right in and to the Marks without the 
express written permission of Avaya or the applicable third party.
Avaya is a registered trademark of Avaya LLC.
All non-Avaya trademarks are the property of their respective owners.
Linux® is the registered trademark of Linus Torvalds in the U.S. and 
other countries.
Downloading Documentation
For the most current versions of Documentation, see the Avaya 
Support website: https://support.avaya.com, or such successor site 
as designated by Avaya.
Contact Avaya Support
See the Avaya Support website: https://support.avaya.com for 
Product or Cloud Service notices and articles, or to report a 
problem with your Avaya Product or Cloud Service. For a list of 
support telephone numbers and contact addresses, go to the Avaya 
Support website: https://support.avaya.com (or such successor site 
as designated by Avaya), scroll to the bottom of the page, and select 
Contact Avaya Support.
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Chapter 1: Introduction

This document contains the procedures to migrate customer information and install patches for 
Avaya Contact Center Select Release 7.1.x.

Purpose
This document contains upgrading checklists and procedures.

Intended audience
This document is intended for people who perform upgrades.

Related resources

Avaya Contact Center Select documentation
The following table lists the documents related to Avaya Contact Center Select. Download the 
documents from the Avaya Support website at https://support.avaya.com.

Title Document purpose Audience
Overview
Avaya Contact Center Select 
Solution Description

This document provides a technical 
description of Avaya Contact Center 
Select. It describes the product 
features, specifications, licensing, and 
interoperability with other supported 
products.

Customers and sales, 
services, and support 
personnel

Table continues…
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Title Document purpose Audience
Avaya Contact Center Select 
Documentation Catalog

This document describes available Avaya 
Contact Center Select documentation 
resources and indicates the type of 
information in each document.

Customers and sales, 
services, and support 
personnel

Contact Center Performance 
Management Data Dictionary

This document contains reference tables 
that describe the statistics and data in the 
historical and real-time reports generated in 
Contact Center.

System 
administrators and 
contact center 
supervisors

Implementing
Deploying Avaya Contact Center 
Select DVD

This document contains information 
about Avaya Contact Center Select 
DVD installation, initial configuration, 
and verification. This document contains 
information about maintaining and 
troubleshooting the Avaya Contact Center 
Select server.

Implementation 
personnel

Deploying Avaya Contact Center 
Select Software Appliance

This document contains information 
about Avaya Contact Center Select 
Software Appliance (VMware) preparation, 
deployment, initial configuration, and 
verification. This document contains 
information about maintaining and 
troubleshooting the software appliance.

Implementation 
personnel

Deploying Avaya Contact Center 
Select Hardware Appliance

This document contains information about 
Avaya Contact Center Select Hardware 
Appliance (physical server) installation, 
initial configuration, and verification. This 
document contains information about 
maintaining and troubleshooting the 
hardware appliance.

Implementation 
personnel

Deploying Avaya Contact Center 
Select on Microsoft Azure

This document contains information about 
deploying Avaya Contact Center Select 
using an ISO image on Microsoft Azure.

Implementation 
personnel

Avaya Contact Center Select 
Business Continuity

This document contains information about 
deploying Avaya Contact Center Select 
Business Continuity.

Implementation 
personnel

Upgrading and Patching Avaya 
Contact Center Select

This document contains information about 
upgrading and patching Avaya Contact 
Center Select.

Implementation 
personnel 
and system 
administrators

Administering
Table continues…
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Title Document purpose Audience
Administering Avaya Contact Center 
Select

This document contains information and 
procedures to configure the users, skillsets, 
and contact center configuration data. 
This document contains information about 
creating Avaya Contact Center Select real-
time and historical reports.

System 
administrators and 
contact center 
supervisors

Avaya Contact Center Select 
Advanced Administration

This document contains information about 
managing the Avaya Contact Center 
Select server, licensing, and multimedia 
configuration.

System 
administrators

Using Contact Center Orchestration 
Designer

This document contains information and 
procedures to configure script and 
flow applications in Contact Center 
Orchestration Designer.

System 
administrators

Maintaining
Contact Center Event Codes This document contains a list of 

errors in the Contact Center suite and 
recommendations to resolve them.

This document is a Microsoft Excel 
spreadsheet.

System 
administrators and 
support personnel

Using
Using Agent Desktop for Avaya 
Contact Center Select 

This document provides information and 
procedures for agents who use the Agent 
Desktop application to accept, manage, 
and close contacts of all media types in 
Contact Center.

Contact center 
agents and 
supervisors

Using the Contact Center Agent 
Browser application

This document provides information and 
procedures for agents who use the Agent 
Browser application to log on to Contact 
Center and perform basic tasks.

Contact center 
agents

Using Avaya Workspaces for AACC 
and ACCS

This document describes the tasks that 
Contact Center agents can perform using 
Avaya Workspaces.

Contact center 
agents and 
supervisors

Release Notes
Avaya Contact Center Select 
Release Notes

The Release Notes contain information 
about known issues, patches, and 
workarounds.

System 
administrators and 
support personnel

Finding documents on the Avaya Support website
Procedure

1. Go to https://support.avaya.com.

2. To log in, click Sign In at the top of the screen and then enter your login credentials when 
prompted.

Related resources
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3. Click Product Support > Documents.

4. In Search Product, start typing the product name and then select the appropriate product 
from the list displayed.

5. In Select Release, select the appropriate release number.

This field is not available if there is only one release for the product.

6. (Optional) In Enter Keyword, type keywords for your search.

7. From the Select Content Type list, select one or more content types.

For example, if you only want to see user guides, click User Guides in the Select Content 
Type list.

8. Click  to display the search results.

Viewing Avaya Mentor videos
Avaya Mentor videos provide technical content on how to install, configure, and troubleshoot 
Avaya products.

About this task
Videos are available on the Avaya Support website, listed under the video document type, and on 
the Avaya-run channel on YouTube.

• To find videos on the Avaya Support website, go to https://support.avaya.com/ and do one of 
the following:

- In Search, type Avaya Mentor Videos, click Clear All and select Video in the Select 
Content Type.

- In Search, type the product name. On the Search Results page, click Clear All and select 
Video in the Select Content Type.

The Video content type is displayed only when videos are available for that product.

In the right pane, the page displays a list of available videos.

• To find the Avaya Mentor videos on YouTube, go to www.youtube.com/AvayaMentor and do 
one of the following:

- Enter a keyword or keywords in the Search Channel to search for a specific product or 
topic.

- Scroll down Playlists, and click a topic name to see the list of videos available. For 
example, Contact Centers.

Note:

Videos are not available for all products.

Introduction
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Support
Go to the Avaya Support website at https://support.avaya.com for the most up-to-date 
documentation, product notices, and knowledge articles. You can also search for release notes, 
downloads, and resolutions to issues. Use the online service request system to create a service 
request. Chat with live agents to get answers to questions, or request an agent to connect you to a 
support team if an issue requires additional expertise.

Support
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Chapter 2: Changes in this release

The following sections outline the Avaya Contact Center Select changes in Release 7.1.x.

Features
See the following sections for information about feature changes.

New features in the Release 7.1 base build
See the following sections for information about new features in Release 7.1 base build:

• Ignition Wizard enhancements on page 13
• Support for Avaya Workspaces on page 13

New features in Release 7.1 Service Packs 1 and 2
There are no new features in Release 7.1 Service Packs 1 and 2.

New features in Release 7.1 Service Pack 3
See the following section for information about new features in Release 7.1 Service Pack 3: Avaya 
Workspaces Service Utility on page 13.

New features in Release 7.1 Feature Pack 1
See the following section for information about new features in Release 7.1 Feature Pack 1: NTP 
configuration of the Avaya Workspaces nodes on page 13.

New features in Release 7.1 Feature Pack 2
See the following sections for information about new features in Release 7.1 Feature Pack 2:

• Ability to deploy Avaya Workspaces at any stage on page 13
• Disabling encryption not required for Contact Center upgrades on page 13

New features in Release 7.1 Feature Pack 2 Post GA Patches
See the following sections for information about new features in Release 7.1 Feature Pack 2 Post 
GA Patches:

• Avaya Contact Center Select Release 7.1 Feature Pack 2 Post GA Patches supports 
Microsoft Windows 11 on page 14
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• Avaya Contact Center Select Release 7.1 Feature Pack 2 Post GA Patches supports 
Microsoft Windows Server 2019 on page 14

New features in Release 7.1.2 Service Pack 2
See the following section for information about new features in Release 7.1.2 Service Pack 2: 
Avaya Workspaces features for Release 7.1.2.2 on page 14.

Ignition Wizard enhancements
From Release 7.1 the following enhancements of Ignitions Wizard are implemented:

• Ignition Wizard now supports chained certificates
• Ignition Wizard now allows to remove the imported certificates
• Password complexity rules of Ignition Wizard are now aligned with Security Manager
• Ignition Wizard now has enhanced validation and reset options

Support for Avaya Workspaces
From Release 7.1, Contact Center supports Avaya Workspaces — a client for the voice, email 
and, web chat contact types.

Avaya Workspaces Service Utility
From Release 7.1 Service Pack 3, you can use the Avaya Workspaces Service Utility. This 
is a new standalone .NET application that enables you to perform service functions for the 
Workspaces cluster. You can use this tool to monitor containers and collect logs.

NTP configuration of the Avaya Workspaces nodes
From Release 7.1 Feature Pack 1, you can synchronize your Avaya Workspaces nodes with 
the Contact Center environment using Network Time Protocol (NTP) servers. Set up the NTP 
servers before deploying or upgrading your Contact Center Release 7.1. You can use from one 
to three NTP servers, however, Avaya recommends that you use three. You can configure time 
synchronization settings in the new Other settings tab while configuring Avaya Workspaces in 
Ignition Wizard (for fresh installs) or in the Update Configurator (for upgrades).

Ability to deploy Avaya Workspaces at any stage
From Release 7.1 Feature Pack 2, you can deploy and configure the Avaya Workspaces cluster at 
any stage after you upgrade to the latest release. Using the Update Configurator, you can deploy 
the Avaya Workspaces cluster either during initial installation and configuration of the Contact 
Center release, or as a Day 2 operation.

Disabling encryption not required for Contact Center upgrades
Release 7.1 Feature Pack 2 removes the requirement to disable encryption when upgrading 
Contact Center, which decreases the overall time of the upgrading process.

Features
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Avaya Contact Center Select Release 7.1 Feature Pack 2 Post GA 
Patches supports Microsoft Windows 11

From Release 7.1 Feature Pack 2 Post GA Patches, Avaya Contact Center Select supports 
Microsoft Windows 11 for Avaya Agent Desktop, Contact Center Manager Administration, Contact 
Center Multimedia Administration, and Communication Control Toolkit.

Avaya Contact Center Select Release 7.1 Feature Pack 2 Post GA 
Patches supports Microsoft Windows Server 2019

Avaya Contact Center Select Release 7.1 Feature Pack 2 Post GA Patches supports the Microsoft 
Windows Server 2019 operating system. Customers that upgrade to Avaya Contact Center Select 
Release 7.1 Feature Pack 2 Post GA Patches and want to use Windows Server 2019 must 
perform a fresh installation on a new Microsoft Windows Server 2019. For more information about 
restoring the database to the new server, see Upgrading and Patching Avaya Contact Center 
Select.

Avaya Workspaces features for Release 7.1.2.2
Release 7.1.2.2 introduces the following Avaya Workspaces features for Avaya Aura® Contact 
Center (AACC) and Avaya Contact Center Select (ACCS). For more information about Avaya 
Workspaces features, see Using Avaya Workspaces for AACC and ACCS.

Consult, transfer, and conference options for web chat
You can consult with another agent during a chat interaction. Messages between agents are 
whispered so the customer does not see them.
If the other agent agrees, you can do one of the following when ending the consultation:

• Transfer the web chat to the other agent.
• Start a conference.

Observe web chat
A supervisor can observe a chat interaction from the My Agents widget.

Whisper coaching during web chat
While observing a chat interaction, the supervisor can start coaching. During the coaching 
session, the supervisor can whisper guidance to the agent. The customer does not see whispered 
messages.

Barge in to web chat
A supervisor can barge in to the chat interaction and communicate with the customer directly.

Email approval
A supervisor can approve or reject an email and add review comments. The agent can edit the 
email and add comments if it is rejected.

Changes in this release
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Reschedule email
You can postpone work on an email and reschedule it for a later time. This is a useful option if you 
need more time to gather information before completing the email.

Email transfer enhancements and new forwarding option
Previously, you could only transfer an email interaction to a skillset. Now, you can also transfer the 
email to another agent. In addition, you can also forward an email to any email address.

Multiple keyword search
You can use multiple keywords when searching through email templates and suggested content.

Customer history view
Customer history information for all contact types (voice and multimedia) is now displayed 
together in the same table.

Other changes
This section lists other changes for Release 7.1.x. Outdated information has been removed.

Other changes in Release 7.1 Feature Pack 2
See the following section for information about other changes in Release 7.1 Feature Pack 2: 
Updated third-party software for the Avaya Workspaces cluster on page 15.

Other changes in Release 7.1.2 Service Pack 2
See the following sections for information about other changes in Release 7.1.2 Service Pack 2:

• Interoperability with the latest WebLM releases on page 15
• VMware support on page 16
• End of support for Internet Explorer on page 16
• Windows operating system support on page 16
• Avaya Aura Media Server interoperability on page 16
• Supported IP Office versions on page 16

Updated third-party software for the Avaya Workspaces cluster
Release 7.1 Feature Packs 1 and 2 include upgrades to a number of third-party components for 
the Avaya Workspaces cluster. Examples of components that have been upgraded to more recent 
versions include Kubernetes, Docker, Istio, and Kafka.

Interoperability with the latest WebLM releases
In Release 7.1.2.2, the latest versions of WebLM 8.1.3.x and 10.1.x are supported.

Other changes
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VMware support
Contact Center Release 7.1.2.2 supports ESXi 7.0 and 8.0 Update 2. Earlier VMware versions, 
including 6.5 and 6.7, are no longer supported.

See the VMware website for general lifecycle policy information.

End of support for Internet Explorer
Microsoft ended support for the Internet Explorer (IE) web browser in June 2022.
Many Contact Center applications, such as Contact Center Manager Administration (CCMA), 
Contact Center Multimedia (CCMM), and Communication Control Toolkit (CCT) require the IE 
engine. To run these applications, you must use Microsoft Edge in IE mode. If you are using 
Windows 10, IE can be disabled but cannot be removed from your computer. With Windows 11, 
you do not need to install the IE browser because Edge already includes the IE engine.

Windows operating system support
The following Microsoft operating systems are no longer supported:

• Windows 7 and 8.1

• Windows Server 2012 R2 and earlier versions

See the Microsoft website for lifecycle policy information.

Avaya Aura® Media Server interoperability
Contact Center now supports Avaya Aura® Media Server Release 10.1.x. Release 8.0.x is also 
supported.

Supported IP Office versions
In Release 7.1.2.2, Avaya Contact Center Select supports IP Office Release 10.1, 11.1.2, and 
11.1.3.x.

Changes in this release
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Chapter 3: Overview

Avaya Contact Center Select Release 7.1.x is supported on the Microsoft Windows Server 2016 
and 2019 operating systems, Standard and Data Center editions. The Microsoft Windows Server 
operating system and server must meet the requirements specified in Avaya Contact Center Select 
Solution Description.

You cannot upgrade directly from Avaya Contact Center Select Release 6.4.2 on Windows Server 
2008 R2 to Avaya Contact Center Select Release 7.1.x on Windows Server 2016 or 2019. You can 
migrate agent and statistical information from your existing Avaya Contact Center Select Release 
6.x solution to Avaya Contact Center Select Release 7.x.

Avaya Contact Center Select minor releases use the application of Release Packs, Feature Packs, 
or Service Packs as the upgrade method. Download and read the Release Notes for additional 
instructions to successfully upgrade Avaya Contact Center Select.

When you upgrade or migrate to Avaya Contact Center Select 7.1.x, you can choose to deploy 
and configure Avaya Workspaces. You must ensure that your solution hardware specifications meet 
the minimum requirements for Avaya Workspaces. For more information about Avaya Workspaces 
hardware requirements, see Avaya Contact Center Select Solution Description.

Important:
• If you are upgrading from Avaya Contact Center Select Release 7.0 or Release 7.0 Service 

Pack 1, you cannot upgrade directly to Avaya Contact Center Select Release 7.0 Feature 
Pack 2 or later. You must upgrade to Avaya Contact Center Select Release 7.0 Feature 
Pack 1 before upgrading to Avaya Contact Center Select Release 7.0 Feature Pack 2 or 
later.

• If you use local WebLM licensing, the WebLM password is reset to the default password 
after you upgrade Avaya Contact Center Select.

You can apply the most recent Avaya Contact Center Select patches to ensure that you have the 
most recent version of the application software, to resolve software issues.

You can apply patches to an Avaya Contact Center Select Business Continuity solution. Both Avaya 
Contact Center Select servers must be updated to the same patch level. Updating an Avaya Contact 
Center Select Business Continuity solution requires careful up-front planning.

To install an Avaya Contact Center Select Service Pack or to migrate Avaya Contact Center Select, 
you must schedule a maintenance cycle and restart the contact center. For more information, read 
the Service Pack Readme file.

Migrating from Avaya Contact Center Select to Avaya Aura® Contact Center is not supported.
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Migrating from an Avaya NES Contact Center AML-based solution to Avaya Contact Center Select 
is supported. Migrating from an Avaya Aura® Contact Center AML-based solution to Avaya Contact 
Center Select is also supported.

Avaya Contact Center Select firewall considerations
Avaya Contact Center Select supplies a customized Windows Firewall Security policy. After you 
install Avaya Contact Center Select, Avaya recommends that you do not make changes to the 
ACCS Firewall Policy.
When you install a Service Pack on your Contact Center server, the Service Pack applies the most 
recent version of the ACCS Firewall Policy. Any changes previously made to the ACCS Firewall 
Policy are therefore lost. If you make changes to the ACCS Firewall Policy, you must manually track 
and manage these changes.

Avaya Contact Center Select Software Appliance migration 
overview

To migrate from an Avaya Contact Center Select Release 6.4.2 or 7.0.x Software Appliance to a 
new Avaya Contact Center Select Release 7.1.x Software Appliance, follow these steps:

1. Deploy an Avaya WebLM Release 8.1.3.x or 10.1.x OVA Software Appliance.

2. Deploy an Avaya Aura® Media Server Release 8.0.x or 10.1 Software Appliance. 
Upgrading from an Avaya Media Server Release 7.6 or 7.7 OVA to a new Avaya Aura®

Media Server OVA Software Appliance is not supported. You can migrate the Application 
Content database from Avaya Media Server Release 7.6 or 7.7 to Avaya Aura® Media 
Server Release 7.8. Upgrading from a Media Server Release 7.8 OVA to an Avaya Aura®

Media Server Release 8.0.x or 10.1 OVA Software Appliance is supported.

3. On the existing Avaya Contact Center Select Release 6.4.2 or 7.0 Software Appliance 
server, back up the databases and CCMA data to a secure network location.

4. Create an Avaya Contact Center Select Release 7.1.x virtual machine:

• Create a VMware virtual machine. Ensure that the virtual machine meets the 
specifications in Avaya Contact Center Select Solution Description.

• Install Microsoft Windows Server 2016 or 2019 Standard or Data Center edition on the 
virtual machine. Use the GUI version of the operating system.

• Format the virtual machine hard disk partitions for Avaya Contact Center Select Release 
7.1.x.

• Using the Avaya Contact Center Select Release 7.1.x DVD, install Avaya Contact 
Center Select without Avaya Aura® Media Server on the Windows Server virtual 
machine. Ensure you select the install option without Avaya Aura® Media Server.

5. Restore the Avaya Contact Center Select Release 6.4.2 or 7.0 databases and CCMA on 
the Avaya Contact Center Select Release 7.1.x virtual machine.

Overview
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6. Take the existing Avaya Contact Center Select Software Appliance offline.

7. Commission Avaya Contact Center Select Release 7.1.x.

For more details about deploying an Avaya Contact Center Select Release 7.1.x Software 
Appliance, see Deploying Avaya Contact Center Select Software Appliance.

Avaya Contact Center Select Hardware Appliance 
migration overview

To migrate from an Avaya Contact Center Select Release 6.4.2 or 7.0 Hardware Appliance to a 
new Avaya Contact Center Select Release 7.1.x Hardware Appliance, follow these steps:

1. On the existing Avaya Contact Center Select Release 6.4.2 or 7.0 Hardware Appliance 
server, back up the databases and CCMA data to a secure network location.

2. Deploy an Avaya Contact Center Select Release 7.1.x Hardware Appliance.

3. Restore the Avaya Contact Center Select Release 6.4.2 or 7.0 databases and CCMA data 
to the Avaya Contact Center Select Release 7.1.x server.

4. Take the existing Avaya Contact Center Select Release 6.4.2 or 7.0 Hardware Appliance 
offline.

5. Commission Avaya Contact Center Select Release 7.1.x.

For more details about deploying an Avaya Contact Center Select Hardware Appliance, see 
Deploying Avaya Contact Center Select Hardware Appliance.

Avaya Contact Center Select Hardware Appliance reuse 
overview

To reuse your existing Avaya Contact Center Select Release 6.4.2 or 7.0 Hardware Appliance for 
Avaya Contact Center Select Release 7.1.x, follow these steps:

1. On the existing Avaya Contact Center Select Release 6.4.2 or 7.0 Hardware Appliance 
server, back up the databases and CCMA data to a secure network location.

2. Take the Avaya Contact Center Select Release 6.4.2 or 7.0 Hardware Appliance offline.

3. Reformat the Hardware Appliance server:

• Install Microsoft Windows Server 2016 or 2019, Standard or Data Center edition. Use 
the GUI version of the operating system.

• Do not upgrade the operating system. Avaya Contact Center Select is not supported on 
an upgraded operating system.

Avaya Contact Center Select Hardware Appliance migration overview
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• Reformat the server hard disk partitions for Avaya Contact Center Select Release 7.1.x.

4. Using the Avaya Contact Center Select Release 7.1.x DVD, install Avaya Contact Center 
Select with Avaya Aura® Media Server software on the Windows Server.

5. Restore the old Avaya Contact Center Select databases and CCMA data to the Avaya 
Contact Center Select Release 7.1.x server.

6. Commission Avaya Contact Center Select Release 7.1.x.

For more details about deploying Avaya Contact Center Select, see Deploying Avaya Contact 
Center Select DVD.

Migrating security certificates
If you have TLS security on any Contact Center services in your existing Release 6.x solution, 
then the existing server has security certificates in one or more of the security stores supported on 
earlier releases. Contact Center Release 7.1 uses a single certificate for both the Contact Center 
security store and the IIS security store.

As a result, you cannot migrate a Contact Center security store from Release 6.x to Release 7.1. 
If you are migrating a secure Contact Center system from Release 6.x, you must create a new 
security store on the Release 7.1 Contact Center server.

If you are migrating from a Release 7.x server and want to reuse the certificates from your existing 
system:

• The new system must have exactly the same name and use the same domain as the existing 
system.

• You can reuse only the certificate in the Contact Center security store.

• Migrating the Contact Center security store is a manual process.

Migrating the Contact Center security store
To migrate the Contact Center security store from an existing Release 7.x server to a new Release 
7.1 server:

• On the existing server, use Security Manager to back up the security store to a directory. 
Ensure you record the password for the old security store.

• Archive the directory into a single file, for example a zip file.
• Save the archived file to a network location.
• After migrating, copy the archived file to the new server and unpack the directory.
• Use Security Manager to restore the security store on the new server.

Configuring a minimum TLS version
From Release 7.0 Feature Pack 1, Contact Center implements Transport Layer Security (TLS) 
version 1.2 as the default minimum version negotiated for secure communications. This is to avoid 
security vulnerabilities that exist in TLS 1.0.

Overview
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For backward compatibility and inter-operation with third-party or custom applications connecting 
to Contact Center, Administrators can set lower versions of TLS on certain communication 
channels.
If your Contact Center solution includes systems that support only lower TLS versions, ensure 
you set the minimum TLS version after migration. For more information on setting minimum TLS 
settings, see Avaya Contact Center Select Advanced Administration.

Database encryption considerations
Upgrades
You can upgrade your Contact Center solution with encrypted or not encrypted databases. The 
preliminary decryption of all databases is not required.

Note:
When downgrading Contact Center, you must decrypt all databases.

Migrations
When you migrate your Contact Center solution, you can restore Contact Center databases that 
are encrypted or are not encrypted.
If you want to restore an encrypted database to the new server, you must ensure that you use the 
same encryption key as the old server. You must also ensure that this existing key is activated 
before you perform the restore.
If you want to use a new encryption key on the new server, restoring an encrypted database is not 
supported. You must decrypt the Contact Center database on the old server before you perform 
the backup.
For more information about database encryption, see Avaya Contact Center Select Advanced 
Administration.

Agent Desktop upgrades
When you migrate or upgrade the Contact Center server, or apply a CCMM patch that includes 
changes for Agent Desktop, a new version of the Agent Desktop client is included.

For ClickOnce deployments, Agent Desktop prompts the agent to install the upgrade when the 
agent opens the client.

For MSI deployments, Avaya recommends that you install the newer version of the Agent Desktop 
client when migrating, upgrading, or patching the ACCS server. Release Bundle zip files include 
an updated Agent Desktop MSI file, if applicable, in the \Install Software\CCMM folder. 
Alternately, you can update the ACCS server and then open Agent Desktop on a client computer.

Database encryption considerations
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Contact Center supports backwards compatibility with the previous Feature Pack or Service Pack 
version of Agent Desktop. This allows you to upgrade the Contact Center server without the 
requirement to upgrade Agent Desktop in a single maintenance window. For example, if you 
upgrade to Release 7.0 Feature Pack 3, you can use the Release 7.0 Feature Pack 2 version 
of Agent Desktop. New Agent Desktop features added in the latest Contact Center release are 
not available until you upgrade Agent Desktop to that release. Backwards compatibility is not 
supported for major or minor releases. For example, if you upgrade to Release 7.1, you cannot 
use the Release 7.0 version of Agent Desktop.

Agent Desktop displays a message to inform you if the Agent Desktop version on the server is 
different to that on the client. For instructions on Agent Desktop silent installation using the MSI, 
see Deploying Avaya Contact Center Select DVD. The MSI uninstalls the previous version of the 
client, you do not need to uninstall it manually.

Overview
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Chapter 4: Avaya Contact Center Select 
migration 

This section describes how to migrate from Avaya Contact Center Select Release 6.4.2 or 7.0 to 
Avaya Contact Center Select Release 7.1.x on a new Windows Server 2016 or 2019 operating 
system. This section also describes how to migrate Avaya Contact Center Select Release 7.1.x data 
from one Windows Server to another.

Existing ACCS server New ACCS server
Avaya Contact Center Select Release 6.4.2 DVD on 
a Windows 2008 R2 server

Avaya Contact Center Select with Avaya Aura®

Media Server Release 7.1.x DVD on Windows 
Server 2016 or Windows Server 2019Avaya Contact Center Select with Avaya Aura®

Media Server Release 7.0 DVD on a Windows 2012 
R2 server
Avaya Contact Center Select with Avaya Aura®

Media Server Release 7.1.x DVD on Windows 
Server 2016 or Windows Server 2019

Avaya Contact Center Select Release 7.1.x is supported on the Standard and Data Center editions 
of Microsoft Windows Server 2016 or 2019. The Microsoft Windows Server operating system and 
server must meet the requirements specified in Avaya Contact Center Select Solution Description.

You cannot upgrade directly from Avaya Contact Center Select Release 6.4.2 on Windows Server 
2008 R2 to Avaya Contact Center Select Release 7.1.x on Windows Server Windows Server 2016 
or 2019. You can migrate agent and statistical information from your existing Avaya Contact Center 
Select Release 6.x solution to Avaya Contact Center Select Release 7.x.

For a migration, you install a new Windows Server with the most recent version of Avaya Contact 
Center Select Release 7.1.x software and import the data from the existing Avaya Contact Center 
Select server.

You can use any account with local administrative rights to install, upgrade, and patch Avaya 
Contact Center Select. You do not need to always use the same account to perform these tasks. 
You can delete or disable the install account at any time, without impacting Avaya Contact Center 
Select operation.

Important:

You must disable the Admin Approval Mode security feature on the Contact Center server. This 
ensures that accounts with local administrative rights get full privileges for running applications 
on the Contact Center server.
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The following steps are a summary of the migration process:

1. On the existing Avaya Contact Center Select server, back up the databases to a secure 
network location.

2. On Windows Server 2016 or 2019, install Avaya Contact Center Select Release 7.1.x 
software.

3. Restore the old Avaya Contact Center Select databases to the new Avaya Contact Center 
Select Release 7.1.x server.

4. Take the existing Avaya Contact Center Select server offline.

5. Commission Avaya Contact Center Select Release 7.1.x.

Do not upgrade your operating system from a previous release to Microsoft Windows Server 2016 
or 2019. Avaya Contact Center Select is not supported on an upgraded operating system.

When you migrate configuration information from the old server to the new server, do not run the 
two application servers simultaneously. Both applications are configured the same, so they attempt 
to access and control the same resources. Continuing to run the old applications in the new Contact 
Center can result in unpredictable behavior.

Prerequisites
On your Voice and Multimedia Contact Server with Avaya Aura® Media Server, you must enable 
CPU Virtualization or Virtualization Technology in the Windows server BIOS. The available 
virtualization settings can vary by server manufacturer and BIOS version. Refer to the server 
manufacturer's documentation to determine which virtualization settings to configure.

Avaya Contact Center Select migration procedures
This task flow shows you the sequence of procedures you perform to migrate existing Avaya 
Contact Center Select data to Avaya Contact Center Select Release 7.1.x on a new Windows 
Server.

Avaya Contact Center Select migration 
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Figure 1: ACCS migration procedures

Avaya Contact Center Select migration procedures
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Figure 2: ACCS migration procedures continued

Avaya Contact Center Select migration 
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Figure 3: ACCS migration procedures continued

Avaya Contact Center Select migration procedures

April 2024 Upgrading and Patching Avaya Contact Center Select 27
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=UpgradingandPatchingAvayaContactCenterSelect&p3=14


Backing up the Avaya Contact Center Select Release 7.x 
databases

About this task
Back up the Avaya Contact Center Select Release 7.x databases so you can restore them on the 
new server after you install the Avaya Contact Center Select Release 7.1 software.
Use this procedure when migrating Avaya Contact Center Select Release 7.x information from 
one Windows server to another.

Procedure
1. Log on to the existing Avaya Contact Center Select Release 7.x server.

2. From the Start menu, in the Avaya area, click Database Maintenance.

3. In the Contact Center Database Maintenance window, in the Main Menu pane, click 
Backup Locations.

4. In the right pane, click Create.

5. From the Drive Letter list, select the network drive on which to store the Voice and 
Multimedia Contact Server database.

6. In the UNC Path box, type the location to store the backup, in the format \\Computer 
Name\Folder\Backup Location.

7. In the Username box, type the user name used to log on to the computer specified in the 
UNC Path box. The user name is in the format Computer Name\Account Name.

8. In the Password box, type the user password.

9. Click Save.

10. In the Contact Center Database Maintenance window, in the Main Menu pane, click 
Immediate Backup.

11. In the Media Type section, select Network Location.

12. From the Backup Location list, select the network drive on which to store the backup.

13. Click Backup.

14. Click Yes, to continue with the backup.

Backing up the Avaya Aura® Media Server database
Before you begin

• Configure the destination File Transfer Protocol (FTP) server and check that it is operational.
• Ensure that you have the address or host name, FTP account details, and path for the 

backup server.

Avaya Contact Center Select migration 
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• Avaya Aura® Media Server must be fully patched before backing up the database.

About this task
Create a location to store backups. You can specify an FTP server to which you can send Avaya 
Aura® Media Server Element Manager backups. Backup the Avaya Aura® Media Server data so 
you can restore it on the new server.

Procedure
1. Log on to the existing Avaya Aura® Media Server.

2. Access the Element Manager with administrator privileges.

3. Expand Tools.

4. Expand Backup and Restore.

5. Select Backup Destinations.

6. On the Backup Destinations window, click Add.

7. On the Backup Destination Properties window, in the Destination Name box, type a name 
for this backup destination.

8. In the Host Name box, type the host name or IP address of the FTP server.

9. In the User Name box, type the FTP user name for the destination server.

10. In the Password box, type the FTP password for the destination server.

11. In the Destination Path box, type the path on the destination server to specify to which 
directory the backup function writes.

12. Click Test. Element Manager tests the details entered by logging on to the specified FTP 
server.

13. Click Save.

14. Select Backup Tasks.

15. On the Backup Tasks window, click Add.

16. On the Add New Backup Task window, in the Backup Task Name box, type a name for 
this backup.

17. Select Application Content.
18. Select System Configuration.

19. Choose the backup destination that you created for the migration.

20. Select Manually, as needed.

21. Click Save.

22. In the Backup Tasks window, select the backup task you created.

23. Click Run Now.

The Confirm Backup window appears, showing the backup task name details about the 
backup.

Backing up the Avaya Aura® Media Server database
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24. Click Confirm.

The History Log Window appears. When the backup is complete, the backup details 
appear in the list.

Backing up the Avaya Contact Center Select Release 6.4 
databases

About this task
Back up the Avaya Contact Center Select Release 6.4 databases so you can restore them on the 
new server after you install the Avaya Contact Center Select Release 7.1 software.

Procedure
1. Log on to the existing Avaya Contact Center Select Release 6.4 server.

2. Click Start > All Programs > Avaya > Contact Center > Database Utilities > Database 
Maintenance

3. In the Contact Center Database Maintenance window, in the Main Menu pane, click 
Backup Locations.

4. In the right pane, click Create.

5. From the Drive Letter list, select the network drive on which to store the Voice and 
Multimedia Contact Server database.

6. In the UNC Path box, type the location to store the backup, in the format \\Computer 
Name\Folder\Backup Location.

7. In the Username box, type the user name used to log on to the computer specified in the 
UNC Path box. The user name is in the format Computer Name\Account Name.

8. In the Password box, type the user password.

9. Click Save.

10. In the Contact Center Database Maintenance window, in the Main Menu pane, click 
Immediate Backup.

11. In the Media Type section, select Network Location.

12. From the Backup Location list, select the network drive on which to store the backup.

13. Click Backup.

14. Click Yes, to continue with the backup.

Avaya Contact Center Select migration 

April 2024 Upgrading and Patching Avaya Contact Center Select 30
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=UpgradingandPatchingAvayaContactCenterSelect&p3=14


Preparing the Avaya Media Server on Windows Content 
Store

Before you begin
• Read the Avaya Contact Center Select Release Notes.
• Apply the most recent Avaya Media Server service packs and Quick Fix Engineering (QFE) 

patches.
• Obtain the most recent version of the Avaya Contact Center Select Release 7.1 DVD. Read 

the Avaya Contact Center Select Release Notes to ensure that you are using the most recent 
version of Avaya Aura® Media Server software.

• Know the Avaya Contact Center Select SIP domain name.

About this task
Prepare the Avaya Media Server Content Store data for upgrade and migration to Avaya Aura®

Media Server Release 8.0.

Procedure
1. Log on to the existing Avaya Contact Center Select Release 6.4 server.

2. Insert the Avaya Contact Center Select Release 7.1 DVD into the DVD drive of your 
Windows Server.

3. On the DVD, navigate to the following folder: \Install Software\AMS\Windows
4. Locate and run the prepareForAAMS77Migration utility.

5. At the Please enter ACC SIP Domain prompt, enter the Avaya Contact Center Select SIP 
domain name.

The utility prepares the Avaya Media Server Content Store data for migration to Avaya 
Aura® Media Server Release 8.0.

Backing up the Avaya Media Server database
Before you begin

• Configure the destination File Transfer Protocol (FTP) server and check that it is operational.
• Ensure that you have the address or host name, FTP account details, and path for the 

backup server.
• Avaya Media Server must be fully patched before backing up the database.

About this task
Backup your existing Avaya Media Server Release 7.6. Create a location to store backups. You 
can specify an FTP server to which you can send Element Manager backups. Backup the Avaya 
Media Server data so you can restore it on the new server.
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Procedure
1. Log on to the existing Avaya Media Server Release 7.6 server.

2. Access the Element Manager with administrator privileges.

3. Expand Tools.

4. Expand Backup and Restore.

5. Select Backup Destinations.

6. On the Backup Destinations window, click Add.

7. On the Backup Destination Properties window, in the Destination Name box, type a name 
for this backup destination.

8. In the Host Name box, type the host name or IP address of the FTP server.

9. In the User Name box, type the FTP user name for the destination server.

10. In the Password box, type the FTP password for the destination server.

11. In the Destination Path box, type the path on the destination server to specify to which 
directory the backup function writes.

12. Click Test. Element Manager tests the details entered by logging on to the specified FTP 
server.

13. Click Save.

14. Select Backup Tasks.

15. On the Backup Tasks window, click Add.

16. On the Add New Backup Task window, in the Backup Task Name box, type a name for 
this backup.

17. Select Application Content.
18. Ensure System Configuration is not selected. Clear System Configuration.

19. Choose the backup destination that you created for the migration.

20. Select Manually, as needed.

21. Click Save.

22. In the Backup Tasks window, select the backup task you created.

23. Click Run Now.

The Confirm Backup window appears, showing the backup task name details about the 
backup.

24. Click Confirm.

The History Log Window appears. When the backup is complete, the backup details 
appear in the list.
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Backing up Contact Center Manager Administration data
Before you begin

• Ensure that you have write privileges on the server where you want to store the 
administration data you are backing up.

About this task
Back up the administration data to a folder to create a snapshot of the administrative data files. 
You can create the folder on another server in your network.

Procedure
1. On the Avaya Contact Center Select Release 6.x server.

2. Click Start  > All Programs  > Avaya  > Contact Center  > Manager Administration  > 
Configuration.

3. In the left pane of the Configuration window, expand Avaya > Applications.

4. In the Avaya Applications Configuration window, select Backup & Restore.

5. In the right pane, click Backup & Restore.

6. In the Contact Center Manager Administration- Backup and Restore utility, select the 
Backup tab.

7. Select the Drive or specify a Network Location where you want to store the backup.

8. Click Next.
9. On the Schedule page, select the frequency and start time for the backup schedule, or 

select Run Now for immediate backups.
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10. Click Next.
11. On the User Account with Administrative Privileges page, type a valid administrator user 

name, password, and domain for the server on which you want to store the backup.

Note:

The default option for the domain is this computer. Avaya recommends that you store 
your backups in a network location.

12. Click Finish.

13. Click Close.

All backups are saved as CCMADataBackup<BackupDateTime>.package.
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Installing Microsoft Windows Server 2016 or Windows 
Server 2019

Before you begin
• Ensure that you have a newly formatted server on which to install Microsoft Windows Server 

2016 or Windows Server 2019. The server must meet the specifications in Avaya Contact 
Center Select Solution Description.

• Do not upgrade your operating system from a previous release. Contact Center is not 
supported on an upgraded operating system.

• Configure all servers for RAID as described in Avaya Contact Center Select Solution 
Description.

• Ensure that you have a DVD for Microsoft Windows Server 2016 or 2019 Standard or Data 
Center edition.

• Ensure that you have a Microsoft Windows Server 2016 or 2019 operating system product 
key.

• Ensure that you know the IP addresses for the contact center subnet.

About this task
Install the Microsoft Windows Server 2016 or Windows Server 2019 Standard or Data Center 
operating system and configure it to support Contact Center server software.
The following table lists the main inputs to consider while installing the operating system:

Name Description
Computer name Do not use spaces or underscores or exceed 15 characters. The name must 

start with an alphabetic character. Server names must adhere to RFC1123. 
Avaya recommends that you configure the server's final production name before 
installing Contact Center software.

The computer name must match the DNS name. It is case sensitive.
Disk drives Format the partitions as required for the server. For more information, see Avaya 

Contact Center Select Solution Description.
Domain name Configure as required for your site.

You must check to ensure the DNS domain name (including case) matches the 
server name if the server is added to a domain after configuration.

Licensing modes Select Per server licensing mode.

Accept the five default concurrent connections.
Network components Configure the IP address, WINS, and DNS for one or two network cards as 

appropriate. Contact Center does not support IPv6.
Network connections If the server has more than one NIC/adapter, ensure contact center subnet is 

displayed first in the network adapter binding order.
Hard Disk Partitions Configure C: drive as the primary drive. Configure the other drives on your server 

to meet the requirements according to Avaya Aura® Contact Center Overview and 
Specification for the server.
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Perform this procedure on each server before you install Contact Center server software on the 
server.

Procedure
1. Insert the Microsoft Windows Server 2016 or Windows Server 2019 Standard or Data 

Center DVD into the DVD drive.

2. Turn on the power to the server.

The server begins to boot up.

3. On the Windows Setup page, select a language from the Language to install list.

4. Select a Time and currency format from the list.

5. Select Keyboard or input method from the list.

6. Click Next.
7. Click Install now.

8. On the Activate Windows window, enter the operating system product key.

9. Click Next.
10. Select a version of Windows Server 2016 or Windows Server 2019 Standard or Data 

Center that includes the Desktop Experience option.

11. Click Next.
12. Read and accept the terms of the license agreement.

13. Click Next.
14. Select Custom: Install Windows only (advanced) to install a clean new installation of the 

operating system.

15. Select the disk partition on which you want to install Windows Server 2016 or Windows 
Server 2019.

You can use the partition management options to configure the partitions on your server.

16. Click Next.

The installation proceeds and automatically restarts the server several times.

17. After completing the installation, log in to the server as Administrator.

You must enter and confirm the Administrator password.

18. After logging in, configure the time zone settings for your server.

19. Specify the server IP address for your Network Interface Card (NIC).

20. Configure your computer name and domain.

21. (Optional) Change the DVD drive letter to E: to ensure the correct drive letters are free for 
the Contact Center application and database hard disk drives and partitions.
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22. Configure the hard disk drives and partitions for this server using the Windows Server 
2016 or Windows Server 2019 Computer Management - Disk Management utility.

23. Install other required drivers for your hardware configuration.

Contact Center hard disk partition sizes
Select your hard disk size and configure the required partitions. For each partition, specify a 
volume size in MBs that when formatted results in a disk partition that is equal to or greater than 
the required minimum partition size.

For improved multimedia offline data retention, Avaya recommends using 1.2 TB hard disks with a 
600 GB partition for multimedia storage.

Table 1: Contact Center hard disk minimum partition sizes

Hard disk drive partition description Drive 
letter

900 GB hard 
disk Minimum 
size partition

1.2 TB hard 
disk Minimum 
size partition

3.2 TB hard 
disk Minimum 
size partition

Operating System drive

Excluding the 350 MB Windows boot loader 
System Reserved partition.

C: 80 GB NTFS 
partition

80 GB NTFS 
partition

80 GB NTFS 
partition

Application drive D: 120 GB NTFS 
partition

120 GB NTFS 
partition

120 GB NTFS 
partition

DVD drive

For continuity and consistency, Avaya 
recommends using Drive letter E: for 
the DVD drive. However, Contact Center 
supports any DVD Drive letter, other than 
the Drive letters listed here for the hard disk 
partitions.

E: — — —

Voice Contact Server database drive F: 200 GB NTFS 
partition

200 GB NTFS 
partition

200 GB NTFS 
partition

Multimedia Contact Server database drive G: 300 GB NTFS 
partition

600 GB NTFS 
partition

600 GB NTFS 
partition

Database journal drive H: 100 GB NTFS 
partition

100 GB NTFS 
partition

100 GB NTFS 
partition

Workspaces partition (W:) W: — — 1.8 TB NTFS 
partition

Table continues…
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Hard disk drive partition description Drive 
letter

900 GB hard 
disk Minimum 
size partition

1.2 TB hard 
disk Minimum 
size partition

3.2 TB hard 
disk Minimum 
size partition

Total 801 GB of 
NTFS 
partitions on a 
formatted 900 
GB hard disk.

1101 GB of 
NTFS 
partitions on a 
formatted 1.2 
TB hard disk.

1101 GB of 
NTFS 
partitions for 
ACCS, and 1.8 
TB NTFS 
partition for 
Avaya 
Workspaces, 
on a formatted 
3.2 TB hard 
disk.

Contact Center requires Hardware RAID-1 with duplicate hard disk drives with identical 
specifications. Therefore as a minimum, the Contact Center server must have two 900 GB hard 
disks or two 1.2 TB hard disks with identical specifications.

Navigating the Microsoft Windows Server 2016 or 
Windows Server 2019 interface

The following table describes some key Microsoft Windows Server 2016 and Windows Server 
2019 user interface items.

User interface item Description
Start menu The Start menu button opens a list of shortcuts to the main administration 

interfaces of the server, including shortcuts to Contact Center applications. The 
Start menu displays the currently logged on user and provides some basic 
server logout and locking functions. This menu offers similar functionality as the 
Windows Server 2012 R2 Start and App pages. Note that Windows Server 2012 
R2 is no longer supported.

Desktop The Desktop screen contains the Windows Start button, Taskbar, Recycle 
Bin, and shortcuts to the Windows Explorer utility, among others. The Taskbar 
displays the Windows Notification Area and System Tray. The notification area is 
located on the right portion of the Taskbar next to the time.

Navigation tips:

• To display the Start menu, on the desktop, click the Windows Start button.
• To access the control panel, on the Start menu, click the Control Panel tile.
• To access administration tools, on the Start menu, click the Windows Administrative Tools 

tile.

The contents of your screens can vary depending on the roles, features, and applications installed 
on your server.
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For more information about the Windows Server 2016 or Windows Server 2019 operating system, 
refer to the Microsoft support website and Microsoft product documentation.

Important:

Instructions in the Contact Center documentation might vary depending on the Windows 
Server version you are using.

Installing the most recent supported operating system 
service packs

Before you begin
• Access the Avaya hotfixes list on the website http://support.avaya.com.
• Review the specifications on operating system service updates in Avaya Contact Center 

Select Solution Description.

About this task
Avaya recommends that you install the most recent supported operating system service packs. 
You must download the supported operating system service pack from the Avaya hotfixes list 
to ensure your Contact Center server software functions correctly with the supported operating 
system patches.

Procedure
1. Review the Contact Center Service Packs Compatibility and Security Hotfixes Applicability 

List to determine the most recent Contact Center supported patches or service packs.

2. Download the appropriate Microsoft Windows Server patches for the Contact Center 
software installed on this server.

3. Install the most recent Microsoft Windows Server service pack that is validated with 
Contact Center by following the Microsoft Installation instructions.

Connecting the server to the network
About this task
Connect the Contact Center server to the local contact center subnet. Disable all unused Network 
Adapters or Network Interface Cards (NICs) to improve network communications and prevent the 
erroneous configuration of unused NICs during Contact Center server commissioning.
Ask your System Administrator to add a Domain Name System (DNS) static entry for this server. 
Each Contact Center server in a domain requires a DNS static entry.
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Procedure
1. Using a network cable, connect the Contact Center server to the contact center subnet. 

The contact center subnet is the network on which the server software applications work 
together to route contacts and generate reports. Use the ping command to test the contact 
center subnet connection.

2. Log on to the server.

3. On the Start screen, click Control Panel  > Network and Internet  > Network and 
Sharing Center  > Change adapter settings.

4. Right-click on the unused Network Adapter, and select Disable.

5. Repeat this procedure for all unused Network Adapters.

Enabling Microsoft Remote Desktop connection
About this task
Enable Microsoft Remote Desktop connection as your remote access tool. Microsoft Remote 
Desktop provides remote access for support on the server.

Procedure
1. Log on to the server with administrator privileges.

2. On the Start screen, select Control Panel  > System and Security.

3. In the System section, select Allow remote access.

4. Click the Remote tab.

5. Select Allow remote connections to this computer.
6. Click Apply.

7. Click OK.

Disabling Admin Approval Mode for Windows Server 
administrators

About this task
Windows Server implements a security feature known as User Account Control (UAC). By 
default, this feature causes applications run by local non built-in administrators to behave as if 
the applications had been run by standard users. Perform this procedure to ensure that local 
administrators get full privileges for running applications.
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Note:
This procedure describes how to disable Admin Approval Mode on the Contact Center server 
using one method only; there are additional methods available. For example, you can also 
administer User Account Control settings for the Contact Center server using a group policy.

Procedure
1. On the Start screen, select Administrative Tools  > Local Security Policy.

2. Under Security Settings, expand Local Policies.

3. Select Security Options.

4. In the policy pane on the right, double-click on User Account Control: Run all 
administrators in Admin Approval Mode.

5. Click the Local Security Setting tab, and select Disabled.

6. Click OK.

If prompted, restart the server.

Disabling Windows Server Automatic Maintenance
About this task
Disable Windows Server Automatic Maintenance while installing Contact Center software. 
Windows Server Automatic Maintenance can occasionally interfere with the real-time 
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requirements for Contact Center. You must therefore temporarily disable Automatic Maintenance 
to install and configure Contact Center software. Re-enable it after deploying Contact Center.

Procedure
1. Log on to the Contact Center server as an administrator.

2. From the Start menu, click Run and type Taskschd.msc.

3. On the Task Scheduler window, in the left pane, click Task Scheduler Library > 
Microsoft > Windows  > TaskScheduler.

4. In the Name column, right-click Idle Maintenance and then click Disable.

5. In the Name column, right-click Regular Maintenance and then click Disable.

6. From the File menu, click Exit.

Creating a shared location for security configuration
About this task
If you want to enable security on the Contact Center server, and complete security configuration 
when installing Contact Center software, you must ensure that a shared network location exists on 
the Contact Center server. You can then export the Certificate Signing Request (CSR) file to this 
location using the Contact Center Ignition Wizard.

Procedure
Create a shared network location on the Contact Center server.

Avaya Contact Center Select migration 

April 2024 Upgrading and Patching Avaya Contact Center Select 42
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=UpgradingandPatchingAvayaContactCenterSelect&p3=14


Installing Avaya Contact Center Select Release 7.1 DVD 
software

Before you begin
• Download the most recent Avaya Contact Center Select patches to the server.
• Download the most recent Avaya Contact Center Select Release Notes.
• Avoid installation from shared locations, because it might lead to installation failure. To 

ensure successful installation, either mount a DVD or download a local copy of a build.
• If you deploy in a virtual environment and want to install Avaya Workspaces, you must 

manually deploy three virtual machines using the Avaya Workspaces Open Virtual Appliance 
(OVA). See Deploying the Avaya Workspaces OVA on page 93.

About this task
Install the Avaya Contact Center Select software and enable your contact center to route contacts 
to the agents.

Procedure
1. Read the Avaya Contact Center Select Release Notes for the most recent instructions.

2. Insert the Avaya Contact Center Select DVD into the DVD drive of your server.

3. If the installation does not automatically start, access the DVD drive and double-click 
Setup.exe.

4. Click Install to install the necessary software libraries on the server.

If you are prompted to accept the Microsoft .NET Framework license agreement, click 
Accept. If you are prompted to restart the server, click Yes.

5. After the prerequisite software and libraries are installed, navigate to the Avaya Contact 
Center Select DVD and double-click Setup.exe to install the application software.

6. The Avaya Contact Center Select installer starts and verifies that the server meets the 
minimum hardware and Operating System requirements:

• If the system checker detects server errors, it displays a System information window 
listing the detected blocking issues. Review the displayed issues, click Cancel, and 
consult Avaya Contact Center Select Solution Description to determine the actions to 
resolve the issue.

• If the system checker detects non-blocking warnings, it displays a System information 
window listing the detected issues. Review the displayed issues and consult Avaya 
Contact Center Select Solution Description to determine the actions to resolve the issue. 
You can ignore warnings if the potential impact to the operation of the contact center is 
understood and not applicable. Click Ignore or Cancel.

• If the system checker does not detect issues, the System information window is not 
displayed.

7. On the Select Deployment Type screen, select Avaya Contact Center Select with 
Avaya Aura® Media Server.
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8. (Optional) If you want to install and configure Avaya Workspaces, select the Configure 
Workspaces check box.

9. Click Next.
10. The Select Destination Drive window appears.

11. From the Journal Database Drives list, select the drive for the database journal file.

12. From the Voice Contact Server Database Drive list, select the drive for the voice 
databases.

13. From the Multimedia Contact Server Database Drive list, select the drive for the Contact 
Center Multimedia database.

14. (Optional) If you deploy on a physical server, under Workspaces Drive, select the drive 
for the Avaya Workspaces database.

Ignore this step if you deploy on a virtual server.

Note:

On virtual installs, the Workspaces Drive option is not available on the Contact Center 
software installer.
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15. In the Service Packs section, browse to locate the folder containing the Avaya Contact 
Center Select product updates.

16. Click Install.
17. The AVAYA GLOBAL SOFTWARE LICENSE TERMS window appears.

18. Read the terms of the license.

• If you accept the terms, click I ACCEPT THE LICENSE TERMS. The installation 
continues.

• If you do not accept the terms, click I DECLINE THE LICENSE TERMS. The installation 
returns to the Select Destination Drive screen. Click Cancel to stop the install.

• To print the license terms, click Print.
19. The MICROSOFT SOFTWARE LICENSE TERMS window appears.

20. Read the terms of the license.

• If you accept the terms, click I ACCEPT THE LICENSE TERMS. The installation 
continues.

• If you do not accept the terms, click I DECLINE THE LICENSE TERMS. The installation 
returns to the Select Destination Drive screen. Click Cancel to stop the install.

• To print the license terms, click Print.
21. The Progress window appears and displays the installation progress.

22. When the software is installed, click Restart to restart the Avaya Contact Center Select 
server.

After you restart the Avaya Contact Center Select server, you must use the Ignition Wizard 
to initialize Avaya Contact Center Select, otherwise Avaya Contact Center Select is not 
operational. For more information about the Ignition Wizard, see the following procedures.

Next steps
Use the Ignition Wizard to configure Avaya Contact Center Select.

Configuring the server installation data
Before you begin

• Obtain an Avaya Contact Center Select license file for your server.
• Know the IP address of the IP Office primary call server.
• Know the IP Office Service User account name and password.
• Know the IP Office System Password. Ask your IP Office Administrator for the System 

Password.
• Configure an IP Office SIP User Extension Number to be used to register Avaya Contact 

Center Select.
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• Configure an IP Office short code to forward customer calls to an Avaya Contact Center 
Select CDN (Route Point).

• If your Avaya Contact Center Select solution is going to support email contacts, know the IP 
address or name of your email host server.

• If your Avaya Contact Center Select solution is going to support email contacts, configure 
the mailbox details on your email server that you use to receive inbound email messages 
intended for the Avaya Contact Center Select. Know the name and password for this 
mailbox.

• You must configure the required language and locale of the Contact Center server operating 
system, if it is not a Latin-1 language, before configuring the Contact Center server using 
the Contact Center Ignition Wizard. For more information about configuring language and 
locale settings on the Contact Center server, see Avaya Contact Center Select Advanced 
Administration.

About this task
Configure the Avaya Contact Center Select installation data to enable communication with an IP 
Office primary call server.
Optionally, if your solution is to support routed email contacts, configure the mailbox details on 
your email server that you use to receive inbound email messages intended for the Avaya Contact 
Center Select. Avaya Contact Center Select logs onto this mailbox on your mail server and 
retrieves email at defined intervals. Email messages are then routed to agents. To route an email, 
Avaya Contact Center Select requires the mailbox name and password.

Procedure
1. Log on to the Avaya Contact Center Select server using the Administrator account details.

2. The Avaya Contact Center Select Welcome screen appears.
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3. Click Next.
4. On the license screen, select I Accept the Terms of the End-User License Agreement.
5. Click Next.

Configuring the server installation data

April 2024 Upgrading and Patching Avaya Contact Center Select 47
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=UpgradingandPatchingAvayaContactCenterSelect&p3=14


6. On the Configuration Data screen, select the IP Office tab.

7. In the IP Office Server section, in the IP Address box, type the IP address of the IP Office 
primary call server.

8. In the Voice Port box, type the port number of the IP Office primary call server. The default 
port number is 5060.

9. From the Transport list, select the network transport communication protocol for the IP 
Office primary call server. The default protocol is TCP.

10. In the IP Office SIP Domain Name box, type the SIP domain name of your IP Office 
primary call server. The Avaya Contact Center Select SIP domain name must match your 
IP Office SIP domain name.

11. In the IP Office SIP Extension section, in the Extension Number box, type the IP Office 
SIP User Extension Number used to register Avaya Contact Center Select.

12. In the IP Office SIP Extension section, in the Password box, type the password of the 
IP Office SIP User Extension Number used to register Avaya Contact Center Select. Enter 
the number that you configured for the Supervisor Settings - Login Code on the user’s 
Telephony tab.

13. In the IP Office SIP Extension section, in the Confirm Password box, re-type the 
password.
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14. In the IP Office Service User section, in the Username box, type the name of the IP 
Office data synchronization service user. Avaya Contact Center Select uses this IP Office 
service user to synchronize agent and supervisor data between Avaya Contact Center 
Select and the IP Office platform.

15. In the IP Office Service User section, in the Password box, type the password of the IP 
Office data synchronization service user.

16. In the IP Office Service User section, in the Confirm Password box, re-type the 
password

17. In the IP Office System Password section, in the Password box, type the System 
Password for your IP Office call server. Ask your IP Office Administrator for the System 
Password.

18. In the IP Office System Password section, in the Confirm Password box, re-type the 
System Password for your IP Office call server.

19. Select the Sample Data tab.

20. In the Contact Center Sample Data section, in the Sample Agent Starting ID box, type 
a phone number for the first sample Avaya Contact Center Select agent. Avaya Contact 
Center Select automatically creates ten sample agents, using this number as the first of 
ten sequential agent numbers. The default number is 6001.
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21. In the Sample CDN (Route Point) box, type a number for the Avaya Contact Center 
Select CDN (Route Point). This number must match an IP Office short code entry number. 
The default number is 3000.

22. In the Callback Mailbox Number box, type the voice mail mailbox number. This voice mail 
number is used by the Customer Service sample application in Orchestration Designer. 
The default number is 6999.

23. In the Sample Agent’s Password section, in the Password box, type a password for the 
Windows accounts of the sample agents. Avaya recommends that you enter a password 
that conforms to your corporate password policy.

24. In the Confirm Password box, re-type the password for the Windows accounts of the 
sample agents.

25. Select the Core tab.

26. In the Avaya Aura® Media Server section, in the IP Address box, type the IP address of 
the Avaya Aura® Media Server.

Important:

You must ensure that this IP address is not in use, and must be in the same subnet as 
the Contact Center server.

27. In the Password box, type a password for the Avaya Aura® Media Server cust account.
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28. In the Confirm Password box, re-type the password.

29. From the IP Office Contact Center Media Services Locale list, select the locale 
(including language and dialects) of the solution environment.

30. In the System Account Configuration section, in the Password box, type a password 
for the Avaya Contact Center Select administration account. The password is not 
checked against the server security policy for minimum password requirements. Avaya 
recommends that you enter a password that conforms to your corporate password policy.

31. In the Confirm Password box, type the password.

32. Select the Licensing tab.

33. From the License Type list, select Local WebLM.

34. Click Browse, and navigate to folder or USB device containing your license file. Load 
the XML license file. If you do not have a USB memory stick or a license file, you can 
click Skip and load the license file later. If you defer licensing configuration, the deferred 
configuration process is more complex and an additional server reboot is required. Avaya 
recommends that you configure Contact Center licensing here using this Licensing tab.
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Important:

You cannot apply your Local WebLM license file until after you configure your 
contact center using the Ignition Wizard. You must apply your license file during the 
commissioning process.

35. Select the Multimedia tab.

36. In the Mailbox Configuration section, from the Mail Provider list, select None, Microsoft 
Exchange, Gmail, Outlook Hotmail, Yahoo, or Other (POP3/IMAP). The default is Microsoft 
Exchange. If Avaya Contact Center Select is not going to process email contacts, select 
None. If you select Gmail, Outlook Hotmail, or Yahoo, the Incoming Mail Server and 
Outgoing Mail Server sections are automatically populated for you.

37. In the Mailbox Configuration section, in the Display Name box, type a display name for 
the mailbox.

38. In the Mailbox Configuration section, in the Email box, type the email address for the 
mailbox. For example, sales@company.com.

39. In the Mailbox Configuration section, in the Password box, type the password for the 
mailbox.

40. In the Mailbox Configuration section, in the Confirm Password box, re-type the 
password for the mailbox.
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41. In the Incoming Mail Server section, in the Host Name box, type the name of the server 
on which email messages are received in your network.

42. In the Incoming Mail Server section, from the Protocol list, select the communication 
protocol for the inbound email server. Select POP3 or IMAP.

43. In the Incoming Mail Server section, from the Encryption list, select the encryption type 
to use.

44. In the Incoming Mail Server section, in the Port box, type the port number of the 
incoming email server. For the POP3 protocol, the default port number is 110. For the 
IMAP protocol, the default port number is 143.

45. In the Outgoing Mail Server section, in the Host Name box, type the name of the server 
from which email messages are sent. Your inbound and outbound mail servers can have 
the same name.

46. For outgoing email, the Protocol is SMTP.

47. In the Outgoing Mail Server section, from the Encryption list, select the encryption type 
to use.

48. In the Outgoing Mail Server section, in the Port box, type the port number of the outgoing 
email server. The default port number is 25.

49. In the Outgoing Mail Server section, from the SMTP Authentication list, select SMTP 
Authentication Disabled or Base 64 Encoded Authentication. The default authentication 
method is Base 64 Encoded Authentication.

50. (Optional) Select the Workspaces tab to configure optional Avaya Workspaces. See 
Configuring Avaya Workspaces during the initial installation on page 95 for the 
configuration details.

51. Select the Security Configuration tab, and configure the security details in the Security 
Store Details section.
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52. If you do not want to enable security, select the Skip Security Configuration checkbox 
and skip to the next steps on page 57.

Important:

A warning message appears. If you proceed without enabling security and IP Office 
is using TLS, the CTI link is disabled until you configure Contact Center TLS 
certificates to communicate securely with IP Office, or until you configure IP Office 
to allow an unsecured CTI connection. After the deployment, to complete your 
security configuration, follow the procedures in Avaya Contact Center Select Advanced 
Administration.

53. In the Full Computer Name (FQDN) box, type the full FQDN of the server on which you 
are creating the security store.

Important:

The FQDN must be the full machine name of the server that the Security Store resides 
on. The FQDN name is case-sensitive.

54. In the Name of Organizational unit box, type the name of the department or division 
within the company.

55. In the Name of Organization box, type the company name.
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56. In the City or Locality box, type the name of the city or district in which the contact center 
is located.

57. In the State or Province box, type the state or province in which the contact center is 
located.

58. In the Two Letter Country Code box, type the country code in which the contact center is 
located.

59. In the Security Store password box, type a password for accessing the new security 
store.

60. In the Confirm Store password box, confirm the password for accessing the new security 
store.

Important:

Ensure you remember this password, because you need it when you log on to Security 
Manager after install. If you forget the password, you cannot access Security Manager.

61. If you are implementing Business Continuity in the contact center, generate the security 
store using Subject Alternative Names (SANs). In the Subject Alternative Name section, 
for each SAN you want to add:

a. From the Type drop-down list, select DNS.

b. In the Value field, type the FQDN for the server.

c. Click Add.

For a Business Continuity system, add the current server FQDN and the Managed name 
for the BC pair.

62. If you want to change the encryption setting, select the required encryption settings from 
the Encryption Algorithm Level and Key Size drop-down lists.

The default value for Encryption Algorithm is SHA256 and the default value for Key Size 
is 2048.

Contact Center displays a warning message if you select SHA1 or 1024. Contact Center 
includes these values for backward-compatibility only, because these settings do not meet 
the industry-recommended level of encryption.

63. Click Create Store.

64. You can now use the Security Configuration tab to create and save a Certificate Signing 
Request (CSR) file.
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65. Click Create CSR File.

66. From the Save In drop-down list, select a shared location in which to save the CSR file 
and click Save.

You must now send the Certificate Signing Request file to a Certificate Authority and 
receive a signed certificate and root certificate to import to the security store.

67. Click Add to import certificates. In the Open dialog box, navigate to the location of a 
certificate and click Open. To remove the imported certificate, select the required certificate 
from the list and click Remove.

You can import either a chained certificate, or separate root and signed certificates. Root 
certificates appear in the Imported Trusted Certificate Authority Root Certificate(s) 
section. A signed certificate appears in the Imported Identity Security Certificate 
section.

If a chained certificate contains both root and signed certificates, you can add root 
certificates and signed certificate simultaneously by importing just one chained certificate.

If a chained certificate contains root certificates only, you can use the chained certificate to 
add all root certificates at a time. To add a signed certificate, click Add and navigate to the 
required signed certificate.

Avaya Contact Center Select migration 

April 2024 Upgrading and Patching Avaya Contact Center Select 56
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=UpgradingandPatchingAvayaContactCenterSelect&p3=14


If you have separate root and signed certificates, you must add them one by one by 
clicking the Add button. Always add a signed certificate last.

Important:

When adding a chained certificate, the system can ask you to enter the password you 
created for accessing the security store. See the previous steps on page 55.

68. Click Next.
69. Review and confirm your inputs, and click Configure.

The configuration utility begins to configure the Avaya Contact Center Select components.

70. When the components are configured, the Configuration Complete screen appears.

71. Click Finish.

72. On the Avaya Contact Center message box, click OK to restart the Avaya Contact Center 
Select server.

Avaya Contact Center Select software is now configured.

Enabling Windows Server Automatic Maintenance
About this task
Enable Windows Server Automatic Maintenance after deploying Contact Center software.

Procedure
1. Log on to the Contact Center server as an administrator.

2. From the Start menu, click Run and type Taskschd.msc.

3. On the Task Scheduler window, in the left pane, click Task Scheduler Library > 
Microsoft > Windows  > TaskScheduler.

4. In the Name column, right-click Idle Maintenance and then click Enable.
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5. In the Name column, right-click Regular Maintenance and then click Enable.

6. From the File menu, click Exit.

Backing up the new Avaya Contact Center Select Release 
7.1 databases

About this task
After running the Ignition Wizard, backup the Avaya Contact Center Select Release 7.1 
databases.
The backup databases capture the system in a known clean state and these might be required 
later if issues arise during data migration.

Procedure
1. Log on to the new Avaya Contact Center Select Release 7.1 server.

2. From the Start menu, in the Avaya area, click Database Maintenance.

3. In the Contact Center Database Maintenance window, in the Main Menu pane, click 
Backup Locations.

4. In the right pane, click Create.

5. From the Drive Letter list, select the network drive on which to store the Voice and 
Multimedia Contact Server database.

6. In the UNC Path box, type the location to store the backup, in the format \\Computer 
Name\Folder\Backup Location.

7. In the Username box, type the user name used to log on to the computer specified in the 
UNC Path box. The user name is in the format Computer Name\Account Name.

8. In the Password box, type the user password.

9. Click OK.
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10. In the Contact Center Database Maintenance window, in the Main Menu pane, click 
Immediate Backup.

11. In the Media Type section, select Network Location.

12. From the Backup Location list, select the network drive on which to store the backup.

13. Click Backup.

14. Click Yes, to continue with the backup.

Using the Contact Center Dashboard
About this task
You can use the Contact Center Dashboard to access Contact Center system tools and diagnose 
system problems. The Contact Center Dashboard displays some Operating System and system 
details such as CPU type, network details, and Operating System activation status.
The Contact Center Dashboard launches automatically the first time the Contact Center server 
boots up.

Procedure
1. The Contact Center Dashboard Welcome message box automatically appears when the 

server starts up.

2. Click OK.
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3. On the Contact Center Dashboard, select the Home tab.

4. Click Refresh All to refresh the Contact Center Dashboard status reports.

5. In the Avaya Contact Center Status section, click View Services to monitor the state of 
the Contact Center Windows services.

6. In the Avaya IP Office Server Availability section, click SIP Gateway Monitor to 
determine if Contact Center is communicating with IP Office.
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7. Select the Connectivity tab.

8. In the SIP Gateway Monitor section, click Launch to monitor the status of the SIP 
connection to IP Office.

9. In the Contact Center Multimedia Dashboard section, click Launch to monitor the 
multimedia mailbox status.

10. In the Contact Center Manager Administration section, click Launch to access Contact 
Center Manager Administration to configure and manage Contact Center resources.

11. In the System Control and Monitoring Utility section, click Launch to monitor, stop, and 
start Contact Center services.

12. In the Contact Center License Manager section, click Launch to monitor license status 
and add additional licensed features.

13. Select Business Continuity Support to configure the Business Continuity feature.
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14. Select the Software tab.

15. Contact Center Version displays the version of the Contact Center software installed on 
the server.

16. Avaya Aura® Media Server displays the version of Avaya Aura® Media Server software 
installed on the server.

17. Ignition Status displays the Contact Center software installation status.

18. Avaya Contact Center Components displays the Contact Center software and patch 
line-up installed on the server.

19. Third Party Software Information displays the versions of the third-party software 
components used by Contact Center that are installed on the server.
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20. Select the System tab.

21. Machine Name displays the host name of the Contact Center server.

22. Windows Domain displays the name of the domain that the Contact Center server is in.

23. Operating System displays the Operating System version.

24. Windows Activation Status displays the Windows Operating System license and 
activation status.

25. RAM displays the amount of RAM memory in the server.

26. CPU displays the type of CPU in the server.

27. Network displays the networking details of the server: IP address and MAC address.

28. Hard Disks displays the number, size, and drive letter of the hard disk volumes in the 
server.
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29. Select the Troubleshooting tab.

30. Select System Errors to access Contact Center events in the Microsoft Windows Event 
Viewer.

31. Select Contact Center Log Files to access Contact Center trace log files.

32. Select Server Configuration to configure Contact Center licensed features and IP Office 
voice network settings.

33. Select Contact Center Documentation to access and download the most recent Contact 
Center documentation from the Avaya support website.

Turning off Contact Center security
About this task
Turn off Contact Center security before you restore a CCMM database from a system that did 
not have security enabled. If you are migrating from an Avaya Contact Center Select Release 7.1 
system that has Contact Center security turned on, you can skip this procedure.
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Before you begin
• Read the security section of Avaya Contact Center Select Solution Description.

Procedure
1. Log on to the Avaya Contact Center Select server as a local administrator.

Warning:

If you log on to the server as a domain administrator, this procedure does not complete 
successfully.

2. From the Start menu, in the Avaya area, click Security Manager.
3. On the Store Access dialog, type the password for the default security store, and click OK.

If this is the first time you logged on to Security Manager, use the default password 
“__avaya”. Security Manager prompts you to change the security store password.

4. On the Security Manager screen, select the Security Configuration tab.

5. Click Security Off.
6. Click Apply.

7. On the Security Change Confirmation dialog, click Confirm.

8. Click Log Out.
9. Restart the Avaya Contact Center Select server.

Next steps
Complete the migration procedures in this book. After the migration, to complete your security 
configuration, follow the procedures in Avaya Contact Center Select Advanced Administration.

Restoring the Avaya Contact Center Select Release 7.x 
databases

Before you begin
• Back up the old databases.
• Map a drive to the database backups.

About this task
Restore the Avaya Contact Center Select Release 7.x databases. You must complete this 
procedure to ensure all databases are restored at the same time.

Procedure
1. From the Start menu, in the Avaya area, click Database Maintenance.
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2. In the Contact Center Database Maintenance window, in the Main Menu pane, click 
Backup Locations.

3. In the Backup Locations pane, click Create.

4. Select the Drive Letter, UNC path, username, and password to specify the network location 
where you stored the server database backup.

5. Click OK.

6. In the Contact Center Database Maintenance window, in the Main Menu pane, click 
Restore.

7. In the Media Type area, select Network Location.

8. In the Application area, select CCT, CCMS, CCMM, ADMIN, and CCMA.

9. From Restore contents, select Data and Offline.

10. From the Backup Location list, select the network drive containing the backed up Avaya 
Contact Center Select server databases.

11. Click Restore.

12. Use the Progress information field to monitor the progress of the restoration.

13. On the Database Maintenance message box, click OK.

Wait for the restore to complete.

14. From the Start menu, in the Avaya area, click Server Configuration.

15. In the Server Configuration window, in the Main Menu pane, click Local Settings.

16. In the Avaya Server Subnet pane, in the IP Address field, enter the IP address of the 
Avaya Contact Center Select server.

17. In the Site Name pane, enter the name of the Avaya Contact Center Select server.

18. Click Apply All.
19. In the Updated IP Warning dialog box, click OK.

20. In the Make changes to AAMS Content Store dialog box, click OK.

21. Restart the Avaya Contact Center Select server.

Logging on to Avaya Aura® Media Server Element Manager
Before you begin

• Obtain a valid user name and password to access Avaya Aura® Media Server Element 
Manager.
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About this task
Log on to the Avaya Aura® Media Server Element Manager to configure Avaya Aura® Media 
Server for Avaya Contact Center Select.
Element Manager (EM) is a web-based administration tool that facilitates the Operation, 
Administration, and Maintenance (OAM) of Avaya Aura® Media Server.

Note:
You must have more than one Avaya Aura® Media Server account managed by separate 
users. If one account is disabled or lost, another account can perform critical tasks, backups 
or recovery. For more information, see Implementing and Administering Avaya Aura® Media 
Server.

Procedure
1. Start a Web browser.

2. In the address box, type the following URL:

https://SERVER_IP_ADDRESS:8443/em
Where SERVER_IP_ADDRESS is the IP address of the Avaya Aura® Media Server.

3. In the User ID box, type the Avaya Aura® Media Server User ID log on account name. The 
default Element Manager user account name is Admin.

4. In the Password box, type the Element Manager password. Use the Admin account 
password. The default password is Admin123$.

5. Click Sign In.

Restoring the Avaya Aura® Media Server database
Before you begin
Copy the backup zip files to the new Avaya Aura® Media Server server. The backup file names 
derive from the name that you entered in Element Manager for the backup task.

About this task
Restore the Avaya Aura® Media Server database backup data.

Procedure
1. Log on to Avaya Aura® Media Server Element Manager.

2. Expand Tools > Backup and Restore > Restore.

3. On the Restore window, from the Restore Source list, select Upload Backup Files.

4. Click Browse.

5. Select the Avaya Aura® Media Server backup that you want to restore.
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6. Click Upload Files.

7. On the Confirm Restore page, review the information and click Confirm to proceed with 
the restore.

8. Restart the server.

Resetting the Avaya Aura® Media Server IP address in 
Element Manager

About this task
When you migrate Avaya Aura® Media Server to a server with a different IP address, the Avaya 
Aura® Media Server database contains the IP address of the old server. You must update the IP 
address in Element Manager to make all administration functions work correctly.

Procedure
1. Log on to Avaya Aura® Media Server Element Manager with Administrative privileges.

2. In the left pane, select System Configuration > Network Settings > IP Interface 
Assignment.

3. Under IPv4 Interfaces, set the Signaling, Media, and Cluster boxes to the IP address of 
the new server.

4. Click Save.

5. After migrating your server and restoring the server databases, some of the old 
configuration settings might not match your new solution. Commission your new server 
in the new solution.

Restoring the Avaya Aura® Media Server default license
About this task
Restore the Avaya Aura® Media Server default license using Element Manager.

Procedure
1. Log on to Avaya Aura® Media Server Element Manager with administrative privileges.
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2. In the left pane, select Licensing  > General Settings.

3. Click Restore Defaults.

4. Click Confirm.

Restoring the Avaya Contact Center Select Release 6.4 
databases

Before you begin
• Back up the old databases.
• Map a drive to the database backups.

About this task
Restore the Avaya Contact Center Select Release 6.4 databases to the Release 7.1 server. After 
you complete this procedure, you must restart your server.

Important:
You must complete this procedure to ensure all databases are restored at the same time.

Procedure
1. From the Start menu, in the Avaya area, click Database Maintenance.

2. In the Contact Center Database Maintenance window, in the Main Menu pane, click 
Backup Locations.

3. In the Backup Locations pane, click Create.

4. Select the Drive Letter, UNC path, user name, and password to specify the network 
location where you stored the server database backup.

5. Click OK.

Restoring the Avaya Contact Center Select Release 6.4 databases

April 2024 Upgrading and Patching Avaya Contact Center Select 69
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=UpgradingandPatchingAvayaContactCenterSelect&p3=14


6. In the Contact Center Database Maintenance window, in the Main Menu pane, click 
Restore.

7. In the Media Type section, select Network Location.

8. In the Application section, select CCT, CCMS, CCMM, and ADMIN.

9. In the Restore contents section, select Data and Offline.

10. From the Backup Location list, select the network drive containing the backed up Avaya 
Contact Center Select server databases.

11. Click Restore.

12. Use the Progress information field to monitor the progress of the restoration.

13. On the Database Maintenance message box, click OK.

Wait for the restore to complete.

14. From the Start menu, in the Avaya area, click Server Configuration.

15. In the Server Configuration dialog box, click Apply All.
16. Restart the server.

Restoring Contact Center Manager Administration data
Before you begin

• Know the network location (in Universal Naming Convention (UNC) format) of the drive for 
the backed up database.

About this task
Restore the Contact Center Manager Administration data to migrate the data to the new server.
When you restore Contact Center Manager Administration data on the server, Avaya Contact 
Center Select automatically creates all of the Windows user accounts associated with each agent 
if they do not exist after the database restore.
If the Contact Center Manager Administration database backup is from a server that was part of a 
workgroup, you can restore the database onto a server that is part of a domain. However, Avaya 
Contact Center Select recreates all of the Windows user accounts that were previously mapped to 
workgroup users; you must use the Contact Center Manager Administration Configuration Tool to 
change agent mappings from the workgroup accounts to domain accounts.
If you restore Contact Center Manager Administration data on a server with a different name, 
Avaya Contact Center Select does not recreate all of the Windows user accounts that were 
previously mapped to workgroup users. You must use the Configuration Tool to change agent 
mappings if you are restoring the database backup onto a server with a different name.
You must restore the CCMA database as part of a matched set; the CCMA data must be restored 
to the same server as its corresponding databases (for example, CCMS, CCT, or CCMM).
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For more information about the Contact Center Manager Administration Configuration Tool, see 
Administering Avaya Contact Center Select.

Procedure
1. From the Start menu, in the Avaya area, click Manager Administration Configuration.

2. In the left pane of the Avaya Configuration window, expand Avaya > Applications > 
Restore.

3. In the right pane, click Restore.

4. On the Restore message box, click OK.

5. In the Contact Center Manager Administration - Restore dialog box, click the Restore 
tab.

6. To select a backup file to restore from, click Browse.

7. In the Select a backup file dialog box, select the required .package file.

8. Click Open.

9. To restore the backup file data onto the administration data server, click Restore Files.

The restore completed successfully message box appears.
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10. Click OK.

Upgrading Contact Center Manager Administration data
Before you begin

• Restore the backed up Contact Center Manager Administration (CCMA) data.

About this task
Upgrade Contact Center Manager Administration (CCMA) data to the Intersystems Caché 
database format used by Avaya Contact Center Select Release 7.1.

Procedure
1. From the Start menu, in the Avaya area, click Manager Administration Configuration.
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2. In the left pane, click Avaya  > Applications  > CCMA System Upgrade Utility.

3. In the right pane, click CCMA System Upgrade Utility.
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4. Click Yes on the confirmation dialog box.

5. On the Upgrade Utility, click Browse and follow the instructions on the CCMA Upgrades 
screen to choose a location.

Select the drive letter as the location of the restored CCMA data. The Upgrade Utility 
automatically detects and appends the correct directory structure for the old system data.

Example of upgrading from an Avaya Contact Center Select Release 6.4 system:
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6. Click Upgrade.

7. Close the Upgrade Utility application. Click Close.

Migrating the Avaya Media Server database
About this task
Migrate the old Avaya Media Server backup data to the data format used by the current release of 
Avaya Aura® Media Server.

Procedure
1. Copy the Avaya Media Server backup Application Content file to the new Avaya Aura®

Media Server server. The backup file name derives from the name that you entered in 
Element Manager for the backup task.

2. Using an SSH client, log on to the new Avaya Aura® Media Server server Linux shell 
console using the cust account.

3. Using the command line, navigate to the folder containing the backup file.

4. Upgrade and restore the backup. On the command line, enter:
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amsupgrade <backupfile name> 
Where <backupfile name> is the Avaya Media Server backup Application Content file.

5. After the upgrade utility completes, reboot the Avaya Aura® Media Server server.

Completing the Avaya Contact Center Select on Linux 
Content Store

Before you begin
• Read the Avaya Contact Center Select Release Notes.
• This procedure requires sroot access. Obtain Enhanced Access Security Gateway (EASG) 

access to Avaya Aura® Media Server so that you can log on as sroot. For more information 
about enabling EASG, see Deploying and Updating Avaya Aura® Media Server Appliance or 
Avaya Aura® Media Server Release Notes.

• Obtain the most recent version of the Avaya Contact Center Select Release 7.1 DVD. Read 
the Avaya Contact Center Select Release Notes to ensure that you are using the most recent 
version of Avaya Contact Center Select software.

About this task
Complete the Avaya Aura® Media Server Content Store data upgrade or migration process. 
This procedure removes any music content groups from the SIP domain namespace that are 
duplicated in the streamsource namespace.
Alternatively, you can choose to manually remove any music content groups from the SIP domain 
namespace that are duplicated in the streamsource namespace. For more information, see Avaya 
Contact Center Select Release Notes.

Procedure
1. Obtain the most recent version of the Avaya Contact Center Select Release 7.1 DVD.

2. Insert the DVD into the DVD drive of your desktop computer.

3. On your desktop computer, navigate to the \\Install Software\AMS\Linux folder on 
the DVD.

4. Using a Secure Copy (SCP) utility, configured to use a Text transfer mode, copy the 
completeAAMS77Migration.py script from the DVD to the existing Avaya Media 
Server Linux server. Copy the script file using Text transfer mode. Do not copy the script 
file using Binary transfer mode.

5. On your Linux server, use the su command to change to the root user account. For 
example:

su - sroot
6. On your Linux server, navigate to the folder containing the 

completeAAMS77Migration.py shell script.
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7. Start the script. For example,

python completeAAMS77Migration.py 
The utility completes the Avaya Aura® Media Server Content Store data migration or 
upgrade.

Starting Contact Center services
About this task
Start the Contact Center services to begin re-configuration after migrating or upgrading a system. 
The database restore and upgrade utilities automatically stop Contact Center services. Start 
Contact Center services to continue commissioning the solution.

Procedure
1. Log on to the Contact Center server.

2. From the Start menu, in the Avaya area, click System Control and Monitor Utility.

3. Click the Contact Center tab.

4. Click Start Contact Center.
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Wait for Contact Center services to start.
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Configuring the Contact Center Manager Administration 
system components

About this task
Configure the Contact Center Manager Administration (CCMA) system components for the new 
solution. Ensure that the Contact Center Manager Server (CCMS), Communication Control Toolkit 
(CCT), Contact Center Multimedia (CCMM), and IP Office settings are correct for the new solution.
To access CCMA and other Contact Center components, use the Microsoft Edge browser in 
Internet Explorer mode.

Procedure
1. In your browser, type the URL of the Avaya Contact Center Select server and then press 

Enter.

The default URL is http://<server name>, where <server name> is the host name 
of the Avaya Contact Center Select Release 7.1.x server.

2. On the main login page, in the User ID field, type the username.

The default user ID is Administrator.

3. In the Password field, type the password.

The default user password is Administrator.

4. Click Log In.

5. On the launchpad, click Configuration.

6. In the left pane, right-click CC and then click Edit Properties.
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7. Ensure the Contact Center Manager Server details match your new solution and then click 
Submit.

8. In the left pane, right-click CCT and then click Edit Properties.

9. Ensure the Communication Control Toolkit details match your new solution and then click 
Submit.

10. In the left pane, right-click CCMM and then click Edit Properties.

11. Ensure the Contact Center Multimedia details match your new solution and then click 
Submit.
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12. In the left pane, right-click IPOFFICE and then click Edit Properties.

13. Ensure the IP Office details match your new solution and then click Submit.
14. Log off from CCMA.

15. Using the System Control and Monitor Utility (SCMU), restart Avaya Contact Center Select 
services.

Configuring the Contact Center Multimedia new details
About this task
Configure the Contact Center Multimedia (CCMM) Dashboard and Administration details.

Procedure
1. Log on to the Contact Center server.

2. From the Start menu, in the Avaya area, click Multimedia Dashboard.

3. On the CCMM Dashboard, under Server Availability, right-click Contact Center Manager 
Administration and select Edit.

4. On the Administrator Login dialog, in the User Name box, type GeneralAdmin.

5. In the Password box, type the password. The default password is “__ccmm!”.

6. Click Login.

7. On the Administrator Login dialog, in the text box, type the name for the current Voice 
and Multimedia Contact Server.
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8. Click Save.

9. Log on to the new Contact Center Manager Administration Web interface with 
administrative privileges.

10. On the Launchpad, click Multimedia.

11. In the left pane, select the Contact Center Multimedia to which you want to log on.

12. Under CCMM Administration, select General Administration.

13. Select Server Settings.

14. Update the server names to match the new Contact Center solution.

15. Under CCMM Administration, on the main menu, select E-mail > General Settings.

16. Under Attachment Files, ensure the Inbound URL, Inbound Share, Outbound URL, 
and Outbound Share locations match the new Contact Center solution.

17. Restart the Contact Center server.
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Chapter 5: Avaya Contact Center Select 
Release Pack, Feature Pack, 
Service Pack, and patch 
installation 

Apply the most recent Avaya Contact Center Select Release Packs, Feature Packs, Service Packs, 
and patches to ensure that you have the most recent version of the application software.

You must use the Avaya Release Pack Installer (RPI) to install Release Packs, Feature Packs, and 
Service Packs.

You must use Update Manager to install patches.

Upgrading Avaya Aura® Media Server to Release 7.1.x
Avaya Contact Center Select Release 7.1.x includes a new version of Avaya Aura® Media Server. 
You must upgrade Avaya Aura® Media Server to the correct version.

Prerequisites
On your Voice and Multimedia Contact Server with Avaya Aura® Media Server, you must enable 
CPU Virtualization or Virtualization Technology in the Windows server BIOS. The available 
virtualization settings can vary by server manufacturer and BIOS version. Refer to the server 
manufacturer's documentation to determine which virtualization settings to configure.

Downloading the latest product documentation
About this task
Download the latest product documentation to ensure that you have the most recent updates. 
Updates in the documentation accurately reflect the latest software changes.

Procedure
1. Log on to the Avaya website at http://support.avaya.com.
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2. Compare the versions of the product documentation on the site with the versions you have.

3. If the version number on www.avaya.com is higher than the version number on the 
documentation you have, download the latest version of the document.

4. Review the Avaya website for release notes and readme files.

Downloading the most recent Contact Center patches to 
the server

About this task
Download the most recent Contact Center patches to the server from https://support.avaya.com to 
ensure that you have the most current software.
You can also download the most recent Avaya Workspaces patches to the server. For more 
information about Avaya Workspaces, see Using Avaya Workspaces for AACC and ACCS.

Procedure
1. Log on to the server using an account with administrator privileges.

2. If a new service pack MSI file is available at https://support.avaya.com, download it and 
save it on the Contact Center server.

Starting or stopping Contact Center services
Before you begin
Ensure that there are no active calls before stopping Avaya Contact Center Select services.

About this task
Use the System Control and Monitor Utility to start or stop all Avaya Contact Center Select 
services.

Procedure
1. Log on to the Avaya Contact Center Select server.

2. From the Start menu, in the Avaya area, click System Control and Monitor Utility.

3. Click the Contact Center tab.
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4. To start Avaya Contact Center Select services, click Start Contact Center.
5. To stop Avaya Contact Center Select services, click Shut down Contact Center.

Disabling Windows Server Automatic Maintenance
About this task
Disable Windows Server Automatic Maintenance while updating Contact Center software. 
Windows Server Automatic Maintenance can occasionally interfere with the real-time 

Avaya Contact Center Select Release Pack, Feature Pack, Service Pack, and patch installation 

April 2024 Upgrading and Patching Avaya Contact Center Select 86
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=UpgradingandPatchingAvayaContactCenterSelect&p3=14


requirements for Contact Center. You must therefore temporarily disable Automatic Maintenance 
to update Contact Center software. Re-enable it after the update.

Procedure
1. Log on to the Contact Center server as an administrator.

2. From the Start menu, click Run and type Taskschd.msc.

3. On the Task Scheduler window, in the left pane, click Task Scheduler Library > 
Microsoft > Windows  > TaskScheduler.

4. In the Name column, right-click Idle Maintenance and then click Disable.

5. In the Name column, right-click Regular Maintenance and then click Disable.

6. From the File menu, click Exit.

Installing Contact Center Release Packs, Feature Packs, 
and Service Packs

Before you begin
• Download the most recent Contact Center Release Pack, Feature Pack, and Service Packs.
• Download the most recent Contact Center software patches.
• Temporarily stop Microsoft Windows Server Automatic Maintenance while you update the 

Contact Center software.
• Avoid installation from shared locations, because it might lead to installation failure. To 

ensure successful installation, mount the Release Bundle or install it locally.
• If you are deploying in a virtual environment and want to install Avaya Workspaces, you must 

manually deploy one virtual machine using the Avaya Workspaces OVA. See Deploying the 
Avaya Workspaces OVA on page 93.
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About this task
Install the most recent Avaya Contact Center Select Release Pack, Feature Pack, and Service 
Packs to take advantage of new features and to ensure that you have the most current application 
updates.
If you are upgrading from Release 7.0 Feature Pack 2 or earlier and your deployment type is 
Voice and Multimedia Contact Server with Avaya Aura® Media Server, the Contact Center Update 
Configurator utility automatically updates Avaya Aura® Media Server to the latest supported 
version and applies the necessary configuration.
If you are upgrading from Release 7.0 Feature Pack 3 or later, you must upgrade Avaya Aura®

Media Server manually. For more information, see Updating Avaya Aura Media Server to Release 
7.1.x on page 89. On a Voice and Multimedia Contact Server with Avaya Aura® Media Server, 
the Linux version of Avaya Aura® Media Server is installed on a Hyper-V instance on Microsoft 
Windows Server 2016 or 2019.

Procedure
1. Open the Release Pack, Feature Pack, or Service Pack zip file.

2. Browse to the Avaya Release Pack Installer directory.

3. Double-click setup.exe.

Contact Center displays the Contact Center Release Pack Installer page.

4. If you downloaded GA patches along with the Release Pack:

a. Select Yes.

b. Click Browse.

c. Browse to the folder where you downloaded the patches and then click OK.

5. (Optional) If you want to configure Avaya Workspaces, select Yes.

6. On the Contact Center Release Pack Installer page, click Next.
7. Accept the license terms when prompted.

The Release Pack Installer shuts down Contact Center and installs the software.

8. When the software update completes successfully, click Restart.
9. When the Contact Center server starts, the Contact Center Update Configurator opens.

10. To configure Avaya Aura® Media Server details, in the IP Address field, type the IP 
address of the Avaya Aura® Media Server.

Important:

Ensure that this IP address is not in use. It must be in the same subnet as the Contact 
Center server.

11. In the Password field, type a password for the Avaya Aura® Media Server cust account.

12. In the Confirm Password field, re-type the password.
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13. (Optional) To configure Avaya Workspaces, use the procedure Configuring Avaya 
Workspaces using the Update Configurator on page 98.

14. When the Contact Center Update Configurator completes the configuration process, click 
Yes to restart the server.

Next steps
• If you have a Business Continuity solution and are upgrading from Release 7.0 Feature 

Pack 2 or earlier on a Voice and Multimedia Contact Server with Avaya Aura® Media 
Server, you must re-configure Avaya Aura® Media Server replication. For more information 
about configuring Avaya Aura® Media Server replication, see Avaya Contact Center Select 
Business Continuity.

• Configure Avaya Aura® Media Server name resolution to ensure that Avaya Aura® Media 
Server can resolve the hostname and FQDN of the CCMA server. For more information 
about Avaya Aura® Media Server name resolution, see Avaya Contact Center Select 
Advanced Administration.

Updating Avaya Aura® Media Server to Release 7.1.x
About this task
Follow the steps in this procedure to update Avaya Aura® Media Server to the latest supported 
version. You can use this procedure to upgrade either a standalone Avaya Aura® Media Server or 
Avaya Aura® Media Server on a Hyper-V instance on your Voice and Multimedia Contact Server.
You must lock Avaya Aura® Media Server before applying patches and unlock it after you install 
the patches. In a multiple node configuration, apply a patch to one node at a time so calls can be 
handled by other nodes in the Contact Center. Follow the procedure for each node.

Before you begin
• Review the Avaya Contact Center Select Release Notes, which are available on the Avaya 

Support website. The Release Notes contain information about known issues, patches, 
procedures, and workarounds.

• Back up Avaya Aura® Media Server before updating it.
• Download the Avaya Aura® Media Server system update and Media Server software update 

ISO files from the Avaya Support website.

Procedure
1. Log on to Element Manager.

2. Navigate to Tools > Manage Software > Update > Upload Updates.

3. Click Choose File and navigate to the location of the system update ISO file.

. For example, select MediaServer_System_Update_8.0.0.xx_xxxx.xx.xx.iso.

4. In the left pane, click Upload.

The page refreshes when the update completes and displays the file details.
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5. Click Choose File and navigate to the location of the software update ISO file.

For example, select MediaServer_Update_8.0.0.xx_xxxx.xx.xx.iso.

6. In the left pane, click Upload.

The page refreshes when the update completes and displays the file details.

7. Click Install Updates and wait for the upgrade to complete.

8. In Element Manager, navigate to System Status > Element Status.

9. Verify that the software versions are correct.

Installing Contact Center patches
Before you begin

• Download the latest documentation. See Downloading the most recent product 
documentation on page 84.

• Download the latest appropriate patch bundles. See Downloading the most recent patches to 
the server on page 85.

• Ensure that you use an account with administrator privileges on your server.
• Temporarily stop Microsoft Windows Server Automatic Maintenance while you update 

Contact Center software.

About this task
Install the latest Contact Center patch bundles to ensure that you have the most current 
development updates, or when you are upgrading your system.
The Contact Center Update Manager displays patches for installed Contact Center applications.

Procedure
1. From the Start menu, in the Avaya area, click Update Manager.
2. Click Install.
3. Click Browse and navigate to the folder where you downloaded the patch bundles.

4. Click Scan for Patches.

The Contact Center Updates section displays the available patches.

5. Select the appropriate patches.

6. Click Install Patch(es).
7. On the License Agreement window, read the End User License Agreement and if 

acceptable, click I accept the terms in the license agreement.
8. Click Continue.

The Update Manager installs the patches and displays a confirmation message.
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9. Click Close.

10. Verify that the newly installed patches appear under Installed Updates.

Next steps
Re-enable Microsoft Windows Server Automatic Maintenance.

Enabling Windows Server Automatic Maintenance
About this task
Enable Windows Server Automatic Maintenance after updating Contact Center software.

Procedure
1. Log on to the Contact Center server as an administrator.

2. From the Start menu, click Run and type Taskschd.msc.

3. On the Task Scheduler window, in the left pane, click Task Scheduler Library > 
Microsoft > Windows  > TaskScheduler.

4. In the Name column, right-click Idle Maintenance and then click Enable.

5. In the Name column, right-click Regular Maintenance and then click Enable.

6. From the File menu, click Exit.
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Chapter 6: Avaya Workspaces upgrades

Migrations
When migrating Avaya Contact Center Select to a new server or virtual guest, install and configure 
Avaya Workspaces on a new server or virtual guest together with the Avaya Contact Center Select 
Release 7.1.x software.
To deploy Avaya Workspaces on a new server, use the following high-level steps for the initial 
installation:

1. When deploying in a virtual environment, manually deploy three virtual machines using the 
Avaya Workspaces OVA. See Deploying the Avaya Workspaces OVA on page 93.

2. When installing the Avaya Contact Center Select software, do the following:
a. Select the Configure Workspaces check box.
b. If you are deploying in a physical environment, select the drive for the Avaya 

Workspaces database.
See Installing Avaya Contact Center Select Release 7.1 DVD software on page 43.

3. In the Ignition Wizard, configure the details for the Avaya Workspaces cluster and NTP 
servers. See Configuring Avaya Workspaces during the initial installation on page 95.

Upgrades and patch installation
To upgrade Avaya Workspaces, you must select the Avaya Workspaces configuration check box 
when installing the Avaya Contact Center Select Release Pack, Feature Pack, or Service Pack in 
the Contact Center Release Pack Installer.
In a virtual environment, if upgrading from a previously configured Avaya Workspaces, you must 
redeploy the Avaya Workspaces cluster using the OVA for the latest release. Shut down the virtual 
machines created from the OVAs for the previous release.
For an Avaya Workspaces patch installation, you must download the Contact Center Workspaces 
Patch Installer application. Hot patching is not supported for Avaya Workspaces upgrades. You must 
upgrade Avaya Workspaces during a scheduled maintenance window.
Use the following steps for upgrading and patching Avaya Workspaces:

1. When deploying in a virtual environment, manually deploy three virtual machines using the 
Avaya Workspaces OVA. See Deploying the Avaya Workspaces OVA on page 93.

2. When installing the Contact Center Release Pack, Feature Pack, or Service Pack, in the 
Contact Center Release Pack Installer, select the check box to configure Avaya Workspaces. 
See Installing Contact Center Release Packs, Feature Packs, and Service Packs on 
page 87.

3. In the Contact Center Update Configurator, configure Avaya Workspaces. See Configuring 
Avaya Workspaces using the Update Configurator on page 98.
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4. To download and install Avaya Workspaces patches, do the following:
a. Download the Contact Center Workspaces Patch Installer application. See 

Downloading Contact Center Workspaces Patch Installer on page 99.
b. Install the Avaya Workspaces patches. See Installing Avaya Workspaces patches on 

page 100.

Deploying the Avaya Workspaces OVA
Before you begin
Download the Avaya Workspaces OVA from the Avaya Support website at https://
support.avaya.com.

Note:
If upgrading from a previously configured Avaya Workspaces installation, you must re-deploy 
the Avaya Workspaces cluster using the OVA, which is shipped with the latest release. Before 
you start deploying new virtual machines, shut down the virtual machines created from OVAs 
of the previous release.

About this task
Use this procedure to deploy optional Avaya Workspaces. Deploy the Avaya Workspaces OVA file 
onto a VMware ESXi host server using vCenter. This creates a virtual machine with the Avaya 
Workspaces software for use in the Contact Center solutions.
You must ensure that the Avaya Workspaces virtual machine meets or exceeds the following 
minimum specifications:

vCPU Minimum CPU 
speed

Virtual memory 
reservation

Hard disk space Number of NICs

8 2400 MHz 32 GB 500 GB 1 VMXNET3 
Network Adapter

Important:
Use this procedure for virtual solutions only. If you deploy on a physical machine, ignore this 
procedure.

Procedure
1. In your vCenter client, select the host server on which to deploy the Avaya Workspaces 

OVA.

2. Select File  > Deploy OVF Template.

3. On the Source window, click Browse.

4. On the Open message box, select the Avaya Workspaces OVA file.

5. Click Open.
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6. On the Source window, click Next.
7. On the OVF Template Details window, verify the details of the Avaya Workspaces OVA 

template and click Next.
8. On the End User License Agreement window, read the license agreement, and if 

acceptable, click Accept.
9. Click Next.

10. On the Name and Location window, type the name of the new Avaya Workspaces virtual 
machine. This is not the server host name, this is the name of the VMware virtual machine 
as it appears in the VMware inventory.

11. Click Next.
12. On the Host and Cluster window, select the host server or cluster on which to deploy the 

Avaya Workspaces OVA. If you selected a cluster, select a Specific Host on that cluster.

13. Click Next to display the Storage window.

14. From the Select a destination storage for the virtual machine files list, select a 
location to store the Avaya Workspaces virtual machine image. Ensure that the storage 
location you select has sufficient available storage space to store a thick provisioned virtual 
machine image.

15. Click Next.
16. On the Disk Format window, select Thin Provision.

17. Click Next.
18. On the Ready to Complete window, verify the deployment settings. If you need to modify 

any of the settings, click Back.

19. Click Power on after deployment.
20. Log on to the Contact Center server using the default credentials.

The user name is root and the password is root01. You must not change the default 
credentials at this step. You can create a new password later when configuring Avaya 
Workspaces in the Ignition Wizard.

21. Enter the # ifconfig command to establish the name of your network adapter.

22. To open the network configuration script, enter the # vi /etc/sysconfig/network-
scripts/ifcfg-ens192 command. Ensure the network adapter name matches your 
environment.

23. Press the Insert key to enter the edit mode.

24. Modify the IPADDR, GATEWAY, NETMASK and DNS fields as required. Ensure the 
BOOTPROTO field is set to none.

25. To save the changes, press Esc and type ':wq!'. To exit without changes, press Esc and 
type ':q!'.
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26. Enter the # systemctl restart network command to restart the network service and 
enable the changes.

27. In VM Options, under VMWare tools section, deselect the Synchronize guest time with 
host check box.

You must use NTP servers for time synchronization of Contact Center machines 
and Avaya Workspaces nodes. You can configure time synchronization settings while 
configuring Avaya Workspaces in the Ignition Wizard for fresh installs or in the Update 
Configurator for upgrades.

Configuring Avaya Workspaces during the initial 
installation

About this task
Use this procedure to configure Avaya Workspaces during the initial installation of Avaya Contact 
Center Select.

Note:
When deploying in a physical environment, ensure that you enter the Cluster IP Address 
for Avaya Workspaces cluster. This is a single IP address that you use to access Avaya 
Workspaces.

Configuring Avaya Workspaces during the initial installation

April 2024 Upgrading and Patching Avaya Contact Center Select 95
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=UpgradingandPatchingAvayaContactCenterSelect&p3=14


Procedure
1. On the Contact Center Ignition Wizard screen, select the Workspaces tab and configure 

the details.

2. In the Workspaces section, click Add next to the IP Address box to add IP addresses of 
the Avaya Workspaces nodes. Click Remove if you want to remove an IP address.

If you deploy Avaya Contact Center Select in a physical environment, you must add three 
IP addresses. Enter IP addresses that are not in use.

If you deploy Avaya Contact Center Select in a virtual environment, you must add one IP 
address.

3. In the Workspaces section, in the Password box, enter the root password for the Avaya 
Workspaces nodes.

The password is checked against the server security policy for minimum password 
requirements. Avaya recommends that you enter a password that conforms to your 
corporate password policy.

Note:

Do not use special symbols: @ # £ & ^.
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4. In the Confirm Password, enter the password again.

5. In the LDAP Server section, in the IP Address box, enter the IP address of the LDAP 
Server.

6. In the Port field, enter the port number of the LDAP protocol.

7. From the Protocol drop-down list, select a type of encryption you want to use:

• TCP

• TLS

8. In the Cluster IP field, enter the IP address of the Avaya Workspaces cluster.

If you deploy in a virtual environment, enter the IP address of the Avaya Workspaces node.

9. Select the Other settings tab to configure NTP servers for time synchronization.

10. In the NTP Servers section, click Add to add an IP address of an NTP server.

You can add up to three IP addresses. To remove the IP address, select the required IP 
address and click Remove.

11. In the SSH session timeout box, type the timeout value in minutes.

The default value is 10 minutes. You can enter the value from 5 to 60 minutes.
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12. In the Cluster time zone section, from the drop-down list, select the time zone of the Linux 
cluster.

Avaya recommends that you use the appropriate time zone of the Windows system. You 
can view the current Windows time zone on the same screen.

13. Click Next.

Configuring Avaya Workspaces using the Update 
Configurator

About this task
After the Avaya Release Pack Installer reboots the server, the Contact Center Update 
Configurator opens so that you can configure Avaya Workspaces.

Before you begin
• If upgrading in a virtual environment, remove the Avaya Workspaces cluster drive on the 

Contact Center server. Typically it is the W:\ drive. From Release 7.1.0.3, this drive is no 
longer required for virtual deployments of Avaya Workspaces.

Procedure
1. On the Contact Center Update Configurator, select the Configure Workspaces tab.

2. Next to the IP Address box, click Add.

If you deploy Avaya Contact Center Select in a physical environment, you must add three 
IP addresses. Enter IP addresses that are not in use.

If you deploy Avaya Contact Center Select in a virtual environment, you must add one IP 
address.

To remove an IP address, select an address and click Remove.

3. In the Cluster IP field, enter the IP address of the Avaya Workspaces cluster.

4. In the Password box, type the root password for the Avaya Workspaces cluster.

The password is checked against the server security policy for minimum password 
requirements. Avaya recommends that you enter a password that conforms to your 
corporate password policy.

Note:

Do not use special symbols: @ # £ & ^.

5. In the Confirm Password box, retype the password.

6. (Optional) To ensure that passwords match, select the Show password check box.

7. In the LDAP IP Address box, type the IP address of the LDAP server.
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8. In the Port field, enter the port number of the LDAP protocol.

9. From the Protocol list, select one of the following encryption types:

• TCP

• TLS

10. To configure NTP servers for time synchronization, select the Other settings tab.

11. To add an IP address of an NTP server, next to the IP Address box, click Add.

You can add up to three IP addresses.

To remove an IP address, select an address and click Remove.

12. In the SSH session timeout box, type the timeout value in minutes.

The default value is 10 minutes. You can enter the value from 5 to 60 minutes.

13. From the Linux cluster time zone list, select the time zone of the Linux cluster.

Avaya recommends that you use the appropriate time zone of the Windows system. You 
can view the current Windows time zone on the same screen.

14. Click Configure.

15. When the Contact Center Update Configurator completes the configuration process, click 
Yes to restart the server.

Downloading Contact Center Workspaces Patch Installer
About this task
The Contact Center Workspaces Patch Installer application is a .net application used for 
upgrading the deployed Avaya Workspaces. This application must be launched from the Contact 
Center server used for the original deployment of the Avaya Workspaces cluster. The application 
is not installed on Contact Center systems, instead it is embedded within each Avaya Workspaces 
Patch Bundle.
When launched on the Contact Center system, the application displays:

• the deployment type and version of the current Contact Center software installation
• the name and version of any Avaya Workspaces Patch installed on the system
• the name and version of the Avaya Workspaces Patch that will be installed
• the name and version of the services already installed on the Avaya Workspaces cluster
• the target version of the service which will be updated during Avaya Workspaces Patch 

installation
The Contact Center Workspaces Patch Installer generates two log files during the 
patch installation process. One log is for the Contact Center Workspaces Patch 
Installer application called WorkspacesPatchInstaller.log. The other log file is for the 
patch itself called Install_WorkspacesPatch_7.x.x.x_x86, where 7.x.x.x is the release 
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number, for example Install_WorkspacesPatch_7.1.0.2_x86. Both logs are located in folder: 
C:\Avaya\Logs\Sysops\WorkspacesPatchInstaller.
Use this procedure to download and launch the Contact Center Workspaces Patch Installer 
application.

Procedure
1. Download the most recent Avaya Workspaces Patch Bundle and the accompanying 

checksum text file from http://support.avaya.com.

2. Using MD5 checksum software, generate a checksum of the downloaded Avaya 
Workspaces Patch Bundle and verify it matches with the content of the downloaded 
checksum text file.

3. Log on to the Contact Center server as Administrator.

4. Extract the downloaded Avaya Workspaces Patch Bundle to a local folder.

The WorkspacesPatchInstaller.exe file is located in the WorkspacesPatchInstaller 
folder.

Next steps
Launch the Contact Center Workspaces Patch Installer and start installing the Avaya Workspaces 
patches.

Installing Avaya Workspaces patches
About this task
Use this procedure to install the Avaya Workspaces Patch Bundle.
You must patch Avaya Workspaces during a maintenance window. You can deploy the Avaya 
Workspaces Patch Bundle in the same maintenance window used for updating and patching 
Contact Center. Note that Avaya Workspaces is not operational during the maintenance window.

Note:
Contact Center services that reside on the Windows Server 2016 and 2019 systems are not 
shut down during the Avaya Workspaces patching process. You do not need to restart Contact 
Center services after the Avaya Workspaces patching process.

Before you begin
• Download the most recent Avaya Workspaces Patch Bundle and the accompanying 

checksum text file from https://support.avaya.com.
• Using MD5 checksum software, generate a checksum of the downloaded Avaya Workspaces 

Patch Bundle and verify it matches with the content of the downloaded checksum text file.
• The Avaya Workspaces patching process requires a functional Avaya Workspaces cluster 

to be available. If the Avaya Workspaces deployment is not detected on the Contact Center 
server, the Contact Center Workspaces Patch Installer application blocks the installation.

Avaya Workspaces upgrades

April 2024 Upgrading and Patching Avaya Contact Center Select 100
Comments on this document? 

http://www.avaya.com/support
http://www.avaya.com/support
https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=UpgradingandPatchingAvayaContactCenterSelect&p3=14


Procedure
1. Log on to Contact Center server as an administrator.

2. Run the kubectl get nodes command to verify that the Avaya Workspaces cluster is 
available.

A list of the available Avaya Workspaces nodes is displayed.

3. Extract the downloaded Avaya Workspaces Patch Bundle to a local folder.

4. From the WorkspacesPatchInstaller folder, launch the 
WorkspacesPatchInstaller.exe file.

5. When prompted, enter the username and password of the Avaya Workspaces cluster.

6. Click OK.

7. Click Install.

The installation process starts. When the installation finishes, the Installed 
successfully message is displayed.

8. Click Close.
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Chapter 7: Business Continuity patching

This section describes how to patch an Avaya Contact Center Select solution using Business 
Continuity.

Patching Avaya Contact Center Select Business 
Continuity

Before you begin
• Ensure that you have a standby server license for the server you are patching.
• Ensure both existing Avaya Contact Center Select servers have the same patch level.

About this task
Apply patches to an Avaya Contact Center Select Business Continuity solution to resolve product 
issues. Both Avaya Contact Center Select servers must be updated to the same patch level.
To install a Contact Center Feature Pack or Service Pack, you must schedule a maintenance 
cycle and restart the contact center. For more information, read the Feature Pack or Service Pack 
Readme file.
If shadowing is stopped for more than 24 hours then you must back up the active server database 
and restore it onto the standby server before re-enabling shadowing. Ensure that the system clock 
time on the Avaya Contact Center Select servers are synchronized.

Procedure
1. Read the patch Readme file.

2. Use the System Management and Monitoring Component (SMMC) utility to stop the Avaya 
Contact Center Select active server.

Note: Stopping the ACCS active server stops the ACCS standby or RGN server.

3. Apply the Avaya Contact Center Select patch to the active server.

4. Apply the Avaya Contact Center Select patch to the standby or RGN server.

5. Start the ACCS active server.

6. When the ACCS active server is running, start the ACCS standby or RGN server.
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Chapter 8: Avaya Aura® Media Server patch 
installation

This chapter outlines how to install patches on Avaya Aura® Media Server. Install an Avaya Aura®

Media Server Quick Fix Engineering (QFE) patch to deliver and apply a patch to Avaya Aura®

Media Server. You must always install QFE patches sequentially, as QFE patches are dependent 
on previous patches. Some Avaya Aura® Media Server patches are simple Quick Fix Engineering 
(QFE) patches.

Some Avaya Aura® Media Server patches are more complex. And some Avaya Aura® Media Server 
patches support Avaya Aura® Media Server version upgrades. You must read each Avaya Aura®

Media Server patch Readme file and the Avaya Contact Center Select Release Notes to determine 
the correct procedures for each patch. The Release Notes contain the known issues, patches, 
procedures, and workarounds specific to a release and patch line-up of Avaya Contact Center 
Select and Avaya Aura® Media Server.

Note:

You can use the procedures in this chapter to patch either a standalone Avaya Aura® Media 
Server, or Avaya Aura® Media Server on a Hyper-V instance on your Voice and Multimedia 
Contact Server.

Logging on to Avaya Aura® Media Server Element Manager
Before you begin

• Obtain a valid user name and password to access Avaya Aura® Media Server Element 
Manager.

About this task
Log on to the Avaya Aura® Media Server Element Manager to configure Avaya Aura® Media 
Server for Avaya Contact Center Select.
Element Manager (EM) is a web-based administration tool that facilitates the Operation, 
Administration, and Maintenance (OAM) of Avaya Aura® Media Server.

Note:
You must have more than one Avaya Aura® Media Server account managed by separate 
users. If one account is disabled or lost, another account can perform critical tasks, backups 
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or recovery. For more information, see Implementing and Administering Avaya Aura® Media 
Server.

Procedure
1. Start a Web browser.

2. In the address box, type the following URL:

https://SERVER_IP_ADDRESS:8443/em
Where SERVER_IP_ADDRESS is the IP address of the Avaya Aura® Media Server.

3. In the User ID box, type the Avaya Aura® Media Server User ID log on account name. The 
default Element Manager user account name is Admin.

4. In the Password box, type the Element Manager password. Use the Admin account 
password. The default password is Admin123$.

5. Click Sign In.

Installing Avaya Aura® Media Server patches
Before you begin

• Read the QFE Readme files for the most recent information and instructions.
• Download the most recent Avaya Aura® Media Server QFE patches and store them in the 

QFE subdirectory. QFE patches are ZIP files, but do not unzip them. The Avaya Aura® Media 
Server patching utility uses the QFE ZIP files. For a Linux server, the default QFE folder 
location is /opt/avaya/app/amsinst/ma/MAS/qfe.

• Back up Avaya Aura® Media Server data before applying patches.

About this task
Install a new Quick Fix Engineering patch to apply a change to the Avaya Aura® Media Server 
system. You must lock Avaya Aura® Media Server before applying patches and unlock it after you 
install the patches.
Review Avaya Contact Center Select Release Notes and follow the instructions in each Avaya 
Aura® Media Server patch Readme file.

Procedure
1. On the Avaya Contact Center Select server, start your web browser.

2. In the address box, type https://<Server_IP_Address>:8443/em, where 
<Server_IP_Address> is the Avaya Aura® Media Server IP address.

3. In the User ID field, type the Avaya Aura® Media Server Element Manager username.

4. In the Password field, type the Avaya Aura® Media Server Element Manager password.

5. Click Log In.
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6. In the navigation pane, click System Status  > Element Status.

7. From the More Actions list, click Pending Lock to lock the Avaya Aura® Media Server 
after all processes finish.

8. Wait for the existing active sessions to end.

9. In the More Actions menu, click Lock.

10. Click Stop and confirm the operation on the following page.

11. Close Element Manager.

12. On Avaya Aura® Media Server, open a Linux terminal.

13. Change to the root user by running the su — command.

14. Run the amspatch list all command to obtain the correct name for the new QFE 
patch:

The name of the file is not necessarily the same as the name of the patch.

15. Under the QFE Name column, note the name of the patch.

16. Install the patches in numerical order.

• To install a new patch on the system, run the amspatch apply <patchname> 
command, where <patchname> is the name of the patch.

• To install all downloaded QFE patches on the system, run the amspatch apply all 
command.

17. When the patch application is complete, open the Element Manager navigation pane, and 
click Tools > Software Inventory.

18. Verify the patch version listed in the Patch Level column.

19. Navigate to System Status > Element Status and then click Start.
20. Confirm the operation.

21. From the More Actions list, click Unlock to unlock Avaya Aura® Media Server.

22. Navigate to System Status > Alarms and check for service-impacting alarms.
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Chapter 9: Avaya Contact Center Select 
AML migration

You can migrate to an Avaya Contact Center Select solution from the following CS 1000 AML-based 
Contact Center solutions:

• Avaya NES Contact Center Release 6.0 or Release 7.0

• Avaya Aura® Contact Center Release 6.2, 6.3, 6.4, or 7.x.

Important:

Avaya Contact Center Select supports migrations only from Avaya NES Contact Center or 
Avaya Aura® Contact Center that were part of AML-based CS 1000 solutions. Avaya Contact 
Center Select does not support the migration of data from CS 1000 SIP-based solutions.

There are many considerations when migrating from an AML-based Contact Center solution to an 
Avaya Contact Center Select solution, including:

• Change of PABX from CS 1000 to IP Office.

• Change of telephony infrastructure.

• Potential change from Windows workgroup to Windows domain.

• Feature differences between the solutions.

• Voice services migration to Avaya Aura® Media Server.

For a complete understanding of the solution migration you must download and read the Avaya 
Aura® Contact Center CS1000 (AML) to Avaya Contact Center Select (IP Office) Migration 
Guidelines application note, available from the Avaya Support website at http://support.avaya.com.
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